Installing LAW PreDiscovery
User Guide
LAW PreDiscovery®, Version 6.17.105

• System Requirements
• Installing LAW PreDiscovery
• License Manager
• Profile Manager
Installing LAW PreDiscovery User Guide

No part of this work may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, or by any information storage or retrieval system, without permission.

While the information contained herein is believed to be accurate, this work is provided "as is," without warranty of any kind. The information contained in this work does not constitute, and is not intended as, legal advice.

LexisNexis and the Knowledge Burst are registered trademarks of Reed Elsevier Properties Inc., used under license. LAW PreDiscovery is a registered trademark of LexisNexis, a division of RELX Inc. Other products or services may be trademarks or registered trademarks of their respective companies.

© 2018 LexisNexis. All rights reserved.

LAW PreDiscovery®
Concordance®
CaseMap®
LexisNexis® Early Data Analyzer
LexisNexis® Early Data Analyzer Web

LAW PreDiscovery®
Version: 6.17.105
LAW Prediscovery Release Date: February 5, 2018
# Table of Contents

Chapter 1 About LAW PreDiscovery ........................................... 5

Chapter 2 What's New in LAW PreDiscovery ............................ 8

Chapter 3 Installing LAW PreDiscovery ................................. 10
   1 System Requirements ....................................................... 10
   2 Installing LAW PreDiscovery ........................................... 15
   3 License Manager ............................................................. 38
   4 LAW Profile Manager ...................................................... 47
   5 Undocked Keys ............................................................... 62

Chapter 4 Using LAW PreDiscovery .......................................... 74
   1 Acquiring Documents ...................................................... 74
      Importing Electronic Discovery ....................................... 74
      ED Loader Settings Prior to importing ................................ 74
      Configuring Import Settings ............................................ 89
      Password ..................................................................... 89
      Reprocessing Failed Items ............................................. 95
      Populating the _GUID Field ............................................ 105

Chapter 5 Administering LAW PreDiscovery ............................. 108
   1 Configuring LAW and SQL ............................................. 108

Chapter 6 Reference Information .............................................. 132
   1 Glossary ..................................................................... 132
   2 Languages .................................................................. 141
   3 License Matrix ............................................................. 142
   4 Unicode Support .......................................................... 149
   5 Keyboard Shortcuts ....................................................... 150
   6 Contacting LexisNexis .................................................... 153

Index ................................................................................. 155
Installing LAW PreDiscovery
User Guide

About LAW PreDiscovery
About LAW PreDiscovery

LexisNexis® LAW PreDiscovery® helps legal professionals and their service providers meet the increasing demands in the discovery of printed and electronic documents. By integrating production-level scanning with robust e-discovery and data processing features, LAW PreDiscovery is optimized to enable scalable execution of even the largest discovery projects, from running multiple computers to batch scan boxes of paper documents to importing millions of e-mails and attachments from mail stores, to full text indexing, querying, and exporting to many other popular litigation support applications.

In practice, LAW PreDiscovery supports these key discovery processes:

- **Prefilter large document sets**

  The LexisNexis® Early Data Analyzer and Lexis Early Data Analyzer Web modules are standalone prefiltering modules available as a complement to the LAW PreDiscovery 6.0 suite. Use them to implement high volume electronic discovery productions. Early Data Analyzer Web indexes, filters, and produces export sets. Culled documents are passed directly to LAW PreDiscovery for full expansion and production.

- **Creating and managing cases**

  LAW PreDiscovery® centers all activities, including data collection, processing, and export on the case. Each case corresponds to a database, which tracks all source files and production files, including graphics and text.

  In the process of creating a new case, you select a database engine, create and name the database, establish a folder structure for documents, and define any additional database fields you will need later for coding. Optionally, to simplify future case creation, you can create case templates that specify pre-defined options.

- **Acquiring documents**

  In this step you may do any of the following activities that bring documents into the case:

  - Import electronic discovery using ED Loader to extract text and to record document metadata in the case database.
  - Scan paper documents to electronic format.
  - Import items and metadata from existing cases and load files.
  - Import existing TIFFs or other kinds of image files.
  - Assign custodians at the batch or source level.
  - Code documents with data fields.

- **Performing quality control**

  The exact nature and timing of quality control activities vary greatly, depending on the type and quality of source documents. Quality control typically involves multiple activities spread throughout the discovery project:

  - Error correction, for example: reviewing and fixing processing errors, keeping detailed logs of warning and other error conditions, and alerting you to suspected file
extensions.

- Tag documents that contain specific text or metadata attributes for the purpose of narrowing consideration to pertinent documents or pages.
- Deduplicate files that were imported during electronic discovery.
- Fix problems with TIFF files using built-in image cleanup tools.

## Batch processing

Batch processing functionality helps to automate various processor-intensive jobs, including: document numbering, image cleanup, endorsing, conversion to TIFF or PDF, printing, and optical character recognition (OCR). LAW PreDiscovery lets you take batch processing to a new level by combining the processing power of multiple computers to join distributed batch processing of large jobs.

## Exporting

LAW PreDiscovery provides a wide range of options for exporting to litigation support applications in a variety of standard formats, including: native files, images, coded data, and OCR text.

For information on LAW PreDiscovery and other litigation support products by LexisNexis, please visit the [LexisNexis PreDiscovery](https://www.lexisnexis.com) website.
What's New in LAW PreDiscovery
What's New in LAW PreDiscovery

Enhancements - LAW PreDiscovery 6.17.102

- RDS_253m.zip is the last NIST version supported using the NIST stored in Access database format. All newer NIST versions are supported through SQLlite or SQL Server.

Virtual Machine Environments for LAW and EDA

- [LAW_and_EDA_VM_Guide.pdf](LAW_and_EDA_VM_Guide.pdf)

For more information on this release and on previous releases of LAW PreDiscovery, see [Release Notes](Release Notes).
Installing LAW PreDiscovery

System Requirements

The system requirements provide the minimum and recommended components to install and run LAW PreDiscovery®.

The following table lists the minimum and recommended components needed to run LAW PreDiscovery:

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer and Processor</td>
<td>Personal computer with a 32- or 64-bit processor. Processor clock speed of 1.7 gigahertz (GHz), 3.0 GHz recommended.</td>
</tr>
<tr>
<td></td>
<td>The use of ED Loader on a computer with the 64-bit version of Outlook 2010, 2013, and 2016 are not yet supported.</td>
</tr>
<tr>
<td>Memory</td>
<td>1 gigabyte (GB) of RAM, 4 GB or above recommended</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>High speed hard drives (7200+ RPM) for workstations.</td>
</tr>
<tr>
<td></td>
<td>100 megabytes (MB) free disk space, 2 GB or more recommended</td>
</tr>
<tr>
<td>Operating System</td>
<td>For computers running LAW PreDiscovery or used for storing image and database files any of the following operating systems may be used:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft 7 (see note below)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Windows 8 (see note below)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Windows 10</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Windows Server 2012</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Windows Server 2012 R2</td>
</tr>
</tbody>
</table>

Note:

If using Windows 7 (and higher), please note the following:

When using LAW PreDiscovery with UAC (User Account Control) enabled, it is recommended that you do not create cases under the Program Files or Program Files (x86) folder. This is a protected location in Windows 7 (and higher) and therefore the case folder is redirected to the virtual store. This virtual store is located in the profile of the current user, for example:
<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| C:\Users\<User>\AppData\Local\VirtualStore\Program Files (x86)\Law50\Cases | Some functions in LAW PreDiscovery will not work properly when this data redirection occurs. To avoid this issue try the following:  
- Disable UAC at your own risk.  
Or  
- Create cases in a network location or other location not treated as a protected location by Windows 7 (and higher).  
The C:\Program Files, C:\Program Files (x86), C:\Program Data, and My Documents directories are treated as protected locations and should not be used for storing case files. |

<table>
<thead>
<tr>
<th>Software Framework</th>
<th>Microsoft .NET Framework 4.5.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard Disk Space for LAW PreDiscovery Case Files</td>
<td>Case databases, electronic documents, and image files, require hard disk space in addition to space required for installation. Exact requirements for case files will vary depending on the size of the project.</td>
</tr>
</tbody>
</table>

Microsoft Access does not need to be installed on a machine in order to create an Access-based case in LAW PreDiscovery. However Access-based cases do not support full-text search.

**Recommended to enable full-text searching:**

- Microsoft SQL Server 2016 Express Edition. This and other editions of SQL Server Express are free but version 2016 is limited to 10 GB total database size.  
    Or  
- Microsoft SQL Server 2014 Express Edition. This and other editions of SQL Server Express are free but version 2014 is limited to 10 GB total database size.  
    Or  
- Microsoft SQL Server 2012 Express Edition. This and other editions of SQL Server Express are free but version 2012 is limited to 10 GB total database size.  
    Or  
- Microsoft SQL Server 2008 Express Edition. Version 2008 R2 is limited to 10 GB and version 2008 is limited to 4 GB total database size.
Component | Requirement
--- | ---
**Component** | **Requirement**

**Required to support full-text searching and database sizes greater than 10 GB:**
- Microsoft SQL Server 2016 (LAW Version 6.17.96+)
  - Or
- Microsoft SQL Server 2014
  - Or
- Microsoft SQL Server 2012
  - Or
- Microsoft SQL Server 2008

For more information on enabling support for SQL Server editions, see [Configuring LAW and SQL](#).

<table>
<thead>
<tr>
<th>Network Bandwidth</th>
<th>10/100 Mbps. Gigabit recommended</th>
</tr>
</thead>
</table>
| **Applicable only if network using a network server to host LAW PreDiscovery case files or associated documents.** | • A scanner that supports ISIS drivers. For a list of scanners that support ISIS drivers, see [http://www.scannerdrivers.com](http://www.scannerdrivers.com).
  - Or
• LexisNexis [LAWtsi (Touch Screen Interface)](http://www.scannerdrivers.com) software with a scanner that supports TWAIN drivers.

| Application Software for Native File Printing | To perform printing on native files that belongs to a case, you must have installed an application external to LAW PreDiscovery that is capable of printing the file. For example:
- Microsoft Office 2010, 2013, or 2016
- Microsoft Office 365 Desktop version is supported in LAW PreDiscovery version 6.16.054+
  - Only the Desktop installed version of Office 365 Outlook is supported for use with LAW PreDiscovery. The cloud version is not supported. Please see [Settings Prior to importing](http://www.scannerdrivers.com) for more information on Office 365 configurations.

- Internet Explorer 11 or higher or Microsoft Edge
- Adobe Acrobat Standard 9 or XI
- Adobe Acrobat Pro 8, X, or XI
- Adobe Acrobat Reader 8, 9, 10, or 11 (Adobe Acrobat Reader is not supported for use with LAW PreDiscovery)
## Component Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>supported but not recommended)</td>
</tr>
<tr>
<td></td>
<td>• Lotus Notes version 8.5 or 9</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Visio version 2003 or higher</td>
</tr>
<tr>
<td></td>
<td>• AutoVue Viewer 19</td>
</tr>
<tr>
<td></td>
<td>• Avantstar Quick View Plus 13 Professional</td>
</tr>
<tr>
<td></td>
<td>If using Quick View Plus Professional, please see Avantstar's license agreement prior to using this application with LAW PreDiscovery®.</td>
</tr>
<tr>
<td></td>
<td>• Corel WordPerfect Office 12</td>
</tr>
<tr>
<td></td>
<td>• eDrawings. A version of EDrawings is required to view or print .DWG files.</td>
</tr>
<tr>
<td></td>
<td>Install one or another version of EDrawings, depending upon your version of LAW PreDiscovery.</td>
</tr>
<tr>
<td></td>
<td>• For LAW PreDiscovery version 6.3, install just eDrawings Viewer 2013 (32-bit version only).</td>
</tr>
<tr>
<td></td>
<td>• For LAW PreDiscovery version 5.9 – 6.2, install just EDrawings 2011 (32-bit version only). For example, if only EDrawings 2009 is installed along with LAW PreDiscovery 5.9 or above, you will be prompted to install EDrawings 2011. It is recommended that you uninstall any versions of EDrawings prior to 2011.</td>
</tr>
<tr>
<td></td>
<td>• For LAW PreDiscovery 5.3.14 – 5.8.17 install just EDrawings 2009.</td>
</tr>
<tr>
<td></td>
<td>• For LAW PreDiscovery versions previous to 5.3.14 install just EDrawings 2008.</td>
</tr>
<tr>
<td></td>
<td>• In version 6.16.054+ standard Google Office docs are supported.</td>
</tr>
<tr>
<td></td>
<td>• In version 6.17.96+ IrfanView was added as a supported graphic viewer application for imaging.</td>
</tr>
<tr>
<td></td>
<td>IrfanView Version 4.44 has been tested.</td>
</tr>
<tr>
<td></td>
<td>The use of ED Loader on a computer with the 64-bit version of Outlook is not yet supported.</td>
</tr>
</tbody>
</table>

### Software Required for Proper Operation

- For importing NSF mail stores, Lotus Notes Version 8.5 or 9.
- To view items launched from LAW PreDiscovery, the associated application must be installed.

### Microsoft Visual C++

- Install the correct version of Microsoft Visual C++ before installing LAW PreDiscovery. See the Microsoft Knowledge Base article "Update for Universal C Runtime in Windows" for the download and instructions.
<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component</td>
<td>Be aware that the LAW PreDiscovery installer attempts to install all Microsoft Visual C++ prerequisites, including:</td>
</tr>
</tbody>
</table>
| Anti-virus Software | - Microsoft Visual C++ 2008 SP1 (x86)  
|                  | - Microsoft Visual C++ 2010 SP1 (x86)  
|                  | - Microsoft Visual C++ 2010 SP1 (x64) - on 64-bit machines only  
|                  | - Microsoft Visual C++ 2012 Update 4 (x86)  
|                  | - Microsoft Visual C++ 2012 Update 4 (x64) - on 64-bit machines only  
|                  | - Microsoft Visual C++ 2015 Update 3 (x86)  
|                  | - Microsoft Visual C++ 2015 Update 3 (x64) - on 64-bit machines only  
| Product Licenses | The LAW PreDiscovery and Early Data Analyzer installer may hang when it attempts to install "Microsoft Visual C++ 2015 Update 3 Redistributable Package (x86)" or Microsoft Visual C++ 2015 Update 3 Redistributable Package (x64)" even if you have installed it prior to the LAW PreDiscovery installation.  
|                 | If this occurs, abort the installation, reinstall the update from the Microsoft Knowledge Base article "Update for Universal C Runtime in Windows", and rerun the LAW PreDiscovery and Early Data Analyzer installer.  
| Anti-virus Software | - Anti-virus software with current definitions.  
|                  | Although anti-virus software is not required, we highly recommend that you install anti-virus software with current definitions on any computer running LAW PreDiscovery.  
|                  | LexisNexis is not liable for any damage caused by viruses embedded within processed documents.  
| Product Licenses | To use LAW PreDiscovery, you need the appropriate product licenses.  
|                  | LAW PreDiscovery stores software licenses on a secure software product key. One software product key can support multiple personal computers as long as each computer can connect to the license server (the computer hosting the software product key).  
|                  | LexisNexis provides the software product key along with the licensed software. Contact your LexisNexis sales representative to obtain additional licenses or software product keys. For more information about contacting LexisNexis, see [Contacting LexisNexis](#).  
|                 | For more information about licensing, see About Licensing.  

© 2018 LexisNexis. All rights reserved.
Installing LAW PreDiscovery

This document provides the steps required to install LAW PreDiscovery®, TIFF/PDF printer drivers, and Sentinel RMS License Manager using the LAW PreDiscovery installer. If you are installing LAW PreDiscovery, these instructions assume that you are installing to a computer that meets or exceeds the system requirements of LAW PreDiscovery.

The LAW PreDiscovery installer can be downloaded from LexisNexis, and is also distributed by removable media, such as DVDs.

To install LAW PreDiscovery (full)

1. Before installation, verify that the correct version of Microsoft Visual C++ is installed. See the Microsoft Knowledge Base article "Update for Universal C Runtime in Windows" for the download and instructions.

   Be aware that the LAW PreDiscovery installer attempts to install all Microsoft Visual C++ prerequisites, including:
   - Microsoft Visual C++ 2008 SP1 (x86)
   - Microsoft Visual C++ 2010 SP1 (x86)
   - Microsoft Visual C++ 2010 SP1 (x64) - on 64-bit machines only
   - Microsoft Visual C++ 2012 Update 4 (x86)
   - Microsoft Visual C++ 2012 Update 4 (x64) - on 64-bit machines only
The LAW PreDiscovery and Early Data Analyzer installer may hang when it attempts to install “Microsoft Visual C++ 2015 Update 3 Redistributable Package (x86)” or Microsoft Visual C++ 2015 Update 3 Redistributable Package (x64)” even if you have installed it prior to the LAW PreDiscovery installation.

If this occurs, abort the installation, reinstall the update from the Microsoft Knowledge Base article "Update for Universal C Runtime in Windows", and rerun the LAW PreDiscovery and Early Data Analyzer installer.

1. Run the installation executable file.
   
   The **Welcome** dialog box opens.

   ![Welcome dialog box](image)

   2. Click **Next**.
      
      The **License Agreement** dialog box opens.
3. Click the **I accept the terms in the licensing agreement** option if you accept the terms, and then click **Next**.

The **Custom Setup** dialog box opens.
By default, LAW PreDiscovery and the TIFF and PDF Printer Drivers are enabled for installation. Early Data Analyzer and Sentinel RMS License Manager are not enabled for installation by default.

When a feature is enabled for installation, the ![ ] icon is displayed next to the feature name. When a feature is disabled for installation, the ![ ] icon is displayed next to the feature name.

The features available for installation are described in the following table.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAW PreDiscovery</td>
<td>Installs LAW50.exe and related folders, system files, templates, and utilities. Also installs the database engine for Microsoft Access-based cases.</td>
</tr>
<tr>
<td>LexisNexis® Early Data Analyzer</td>
<td>Provides advanced prefiltering functionality. Requires additional licensing to run. For more information on licensing, contact LexisNexis Sales by e-mailing <a href="mailto:LNGGlobalOpsLitigationsSalesTeam@ReedElsevier.com">LNGGlobalOpsLitigationsSalesTeam@ReedElsevier.com</a>. Or to contact Technical Support, e-mail <a href="mailto:lawsupport@lexisnexis.com">lawsupport@lexisnexis.com</a> or call 1 (866) 831-0497.</td>
</tr>
<tr>
<td>TIFF / PDF Printer</td>
<td>A driver for batch printing, and for batch- and single-</td>
</tr>
</tbody>
</table>
Drivers

TIFF/PDF conversion. Supports text extraction during TIFF/PDF conversion. Installation is recommended.

Also includes the LexisNexis Image Driver 300 DPI Printer. This is used to convert documents to TIFF at a resolution of 300 dots per inch.

Although the Informatik Image Driver is supported for batch- and single-document TIFFing, it is not installed with the full installation of LAW PreDiscovery.

Sentinel RMS License Manager (Install Only)

This component is required to manage software product keys for LAW PreDiscovery and Early Data Analyzer licenses.

Sentinel RMS License Manager only needs to be installed on a machine if the machine is a license server for LAW PreDiscovery and Early Data Analyzer, and if software product keys will be hosted on the machine.

Sentinel RMS License Manager cannot be fully uninstalled using the LAW PreDiscovery installer. If you need to uninstall Sentinel RMS License Manager, please use the Add/Remove Programs feature in the Control Panel.

5. To change the feature installation settings, click the down arrow, next to the feature name and click the installation setting you want to use for the feature installation.
By default, LAW PreDiscovery and Early Data Analyzer are installed in the \Program Files(x86)\LAW50\ directory.

6. If you want to change the installation directory, in the Custom Setup dialog box, click the Change button.

Clicking the Change button opens the Change Current Destination Folder dialog box.
7. Modify the installation directory, and then click **OK** to save your changes.

8. In the **Custom Setup** dialog box, click **Next**.

9. If you chose to install Early Data Analyzer, the Configure Early Data Analyzer Service dialog opens.
10. Leave **User Account** selected in the **Run As** list (recommended) and then type a user name, and provide a password for a Microsoft Windows account that has access to SQL Server and has network access.

⚠️ The **User Account** setting is required to operate LexisNexis® Early Data Analyzer in a distributed environment. The user you select must have permissions to access the network resources and to operate the SQL Server instance that will be used by Early Data Analyzer. For more information on network resources required to set up Early Data Analyzer for distributed processing, see documentation for Early Data Analyzer.

If you select **Local System Account** from the **Run As** list, Early Data Analyzer will not be able to run in a distributed environment. **Local System Account** should only be selected for a single station installation where the SQL Server is hosted on the same station and all file resources are accessed locally.

11. Click **Next**.

   The **Ready to Install the Program** dialog box opens.
12. Click **Install**.

When the installation is complete, the **InstallShield Wizard Completed** dialog box opens.
If you would like to create desktop shortcuts for LAW PreDiscovery and Early Data Analyzer, you can create desktop shortcuts from the LAW PreDiscovery and Early Data Analyzer .exe files. The Law50.exe file is located in the ...\Program Files (x86)\Law50 directory, and the LexisNexis.EdAnalyzer.exe file is located in the ...\Program Files (x86)\Law50\EDAnalyzer64 directory.

To use software key licensing or a temporary license key for LAW PreDiscovery and Early Data Analyzer, you need to activate the software product key or temporary license key before being able to access the LAW PreDiscovery and/or Early Data Analyzer functionality permitted by the licenses in the software product key or temporary license key.

- To activate a software product key, see License Manager.

To upgrade LAW PreDiscovery and/or Early Data Analyzer

1. Before installation, verify that the correct version of Microsoft Visual C++ is installed. See the Microsoft Knowledge Base article "Update for Universal C Runtime in Windows" for the download and instructions.

- Be aware that the LAW PreDiscovery installer attempts to install all Microsoft Visual C++ prerequisites, including:
  - Microsoft Visual C++ 2008 SP1 (x86)
The LAW PreDiscovery and Early Data Analyzer installer may hang when it attempts to install "Microsoft Visual C++ 2015 Update 3 Redistributable Package (x86)" or Microsoft Visual C++ 2015 Update 3 Redistributable Package (x64) even if you have installed it prior to the LAW PreDiscovery installation.

If this occurs, abort the installation, reinstall the update from the Microsoft Knowledge Base article "Update for Universal C Runtime in Windows", and rerun the LAW PreDiscovery and Early Data Analyzer installer.

2. Run the installation executable file.

The **Welcome** dialog box opens.
3. Click **Next**.

   The **License Agreement** dialog box opens.
Installing LAW PreDiscovery

**License Agreement**
Please read the following license agreement carefully.

**END USER LICENSE AGREEMENT - LITIGATION SOFTWARE PRODUCTS**

THE FOLLOWING TERMS APPLY TO THE FURNISHING OF THIS SOFTWARE AND SERVICES. LexisNexis, a division of Reed Elsevier, Inc. ("Company") LICENSES THIS SOFTWARE. CAPITALIZED TERMS ARE DEFINED IN THE LAST SECTION OF THIS AGREEMENT.

IMPORTANT—READ CAREFULLY: This End User License

- [ ] I accept the terms in the license agreement
- [ ] I do not accept the terms in the license agreement

**Version 6.16.054 and below**

**Terms & Conditions**

**END USER LICENSE AGREEMENT - LITIGATION SOFTWARE PRODUCTS**

THE FOLLOWING TERMS APPLY TO THE FURNISHING OF THIS SOFTWARE AND SERVICES. LexisNexis, a division of RELX Inc., licenses this software. Capitalized terms are defined in the last section of this agreement.

- [ ] I accept the terms in the license agreement
- [ ] I do not accept the terms in the license agreement

**Version 6.17.XX++**
4. Select **I accept the terms in the licensing agreement** if you accept the terms, and then click **Next**.

The **Custom Setup** dialog box opens.

![Custom Setup dialog box](image)

By default, the LAW PreDiscovery features currently installed on the computer, including Early Data Analyzer, are enabled for upgrade in the **Custom Setup** dialog box, and the ![enabled icon](image) icon is displayed next to the feature name. By default, any LAW PreDiscovery feature not currently installed on the computer will have the ![disabled icon](image) icon is displayed next to the feature name.

5. To change the feature upgrade settings, click the down arrow, ![arrow icon](image), next to the feature name, and then click the installation setting you want to use for the feature upgrade.

When a feature is enabled for upgrading, the ![enabled icon](image) icon is displayed next to the feature name. When a feature is disabled for upgrading, the ![disabled icon](image) icon is displayed next to the feature name.
If you are upgrading from LAW 6.5/EDA 1.5 or earlier to LAW 6.6/EDA 1.6 or later, make sure you select **This feature will be installed on local hard drive** or **This feature, and all subfeatures, will be installed on local hard drive** for Sentinel Protection Server in the **Custom Setup** dialog box if you are hosting a key on the machine. This is required in order to update the existing version of Sentinel Protection Server to the latest version.

**Caution:** If a LAW PreDiscovery feature is currently installed, and you disable the feature for upgrading by selecting **This feature will not be enabled**, the installed feature will be uninstalled when the installation runs. For example, if you have LAW PreDiscovery and Early Data Analyzer installed, and you change the LAW PreDiscovery feature to **This feature will not be enabled**, then LAW PreDiscovery will be uninstalled when Early Data Analyzer is upgraded during the installation.

If you accidentally uninstall a feature when upgrading, do the following to reinstall the feature:

1. Run the installation executable file or navigate to **Control Panel > Programs and Features**, click **LAW PreDiscovery**, and then click **Change**.
2. In the **Welcome** dialog box, click **Next**.

3. In the **Program Maintenance** dialog box, click the **Modify** option, and then click **Next**.

4. In the **Custom Setup** dialog box, make sure **This feature will be installed on local hard drive** or **This feature, and all subfeatures, will be installed on local hard drive** is selected for each feature that is currently installed on your machine and each feature you want to install.

5. Click **Next**.

6. In the **Ready to Modify the Program** dialog box, click **Install**.

7. In the **InstallShield Wizard Completed** dialog box, click **Finish**.

By default, LAW PreDiscovery and Early Data Analyzer are installed in the **...\Program Files(x86)\LAW50** directory.

6. If you want to change the installation directory, in the **Custom Setup** dialog box, click **Change**.

Clicking **Change** opens the **Change Current Destination Folder** dialog box.
7. Modify the installation directory, and then click **OK** to save your changes.

8. In the **Custom Setup** dialog box, click **Next**.

9. If you chose to upgrade Early Data Analyzer to Early Data Analyzer, the Configure Early Data Analyzer Service dialog opens.
10. Leave **User Account** selected in the **Run As** list (recommended) and then type a user name, and provide a password for a Microsoft Windows account that has access to SQL Server and has network access.

⚠️ The **User Account** setting is required to operate Early Data Analyzer in a distributed environment. The user you select must have permissions to access the network resources and to operate the SQL Server instance that will be used by Early Data Analyzer. For more information on network resources required to set up DiscoveryIQ Processing for distributed processing, see documentation for LexisNexis® Early Data Analyzer.

If you select **Local System Account** from the **Run As** list, Early Data Analyzer will not be able to run in a distributed environment. **Local System Account** should only be selected for a single station installation where the SQL Server is hosted on the same station and all file resources are accessed locally.

11. Click **Next**.

The **Ready to Install the Program** dialog box opens.
12. Click **Install**.

When the installation is complete, the **InstallShield Wizard Completed** dialog box opens.
13. Click **Finish**.

After clicking **Finish**, the **LAW PreDiscovery Installer Information** dialog box may open.

14. Do one of the following:
   - Click **Yes** to restart the computer immediately.
   - Click **No** to restart the computer at a later time.

To run a silent installation
When you need to install the full version of LAW PreDiscovery, including Early Data Analyzer, on numerous machines, you can save time by running silent installations of LAW PreDiscovery and Early Data Analyzer on each machine. Silent installations install applications without prompting you for input during the installation.

1. Click **Start** and then click **Run**.
   
   Clicking **Run** opens the **Run** dialog box.

2. In the **Open** field, type `cmd`, and then click **OK**.
   
   Clicking **OK** opens a DOS prompt.

3. Enter the following, including the quotation marks:

   ```
   law_full_<version>.exe /s /v"/qn ADDLOCAL=<features> <options>"
   ```

   In the statement above, replace the `<version>`, `<features>`, and `<options>` with the applicable installation information.

4. Replace `<version>` with the LAW PreDiscovery version in the LAW PreDiscovery installation .exe file name.

   For example: `law_full_6.10.0.exe`
5. Replace `<features>` with the list of features you want to install.

Use the following format for adding features to the statement (notice comma between each feature with no spaces, and feature names are case-sensitive):

ADDLOCAL=Feature1,Feature2,Feature3...

Features available for installation:

- **LawPreDiscovery** - installs the LAW PreDiscovery application
- **Printers** - installs the TIFF and PDF Print Drivers
- **EarlyDataAnalyzer** - installs the Early Data Analyzer application and service
- **SPNServer** - installs the Sentinel Protection Server for hosting LAW PreDiscovery license keys
- **RMSServer** - installs the Sentinel RMS License Manager for managing software product keys

For example: **ADDLOCAL=LawPreDiscovery,Printers,EarlyDataAnalyzer <options>"**

6. Replace `<options>` with the list of options you want to include in the installation.

Use the following format for adding options to the statement (notice single space between each option with no commas):

OPTION1=VALUE OPTION2=VALUE OPTION3=VALUE...

Options available for installation:

- **EDA_SVC_AS_USER** - determines whether a specific user or LocalSystem is used for the Early Data Analyzer service

  Available Values:
  - **0** - Install with Early Data Analyzer LocalSystem account, EDA_SVC_USERNAME and EDA_SVC_PASSWORD are not required (default)
  - **1** - Install with a specific user account, EDA_SVC_USERNAME and EDA_SVC_PASSWORD are required

- **EDA_SVC_USERNAME** - User name to use for the Early Data Analyzer service. User name and password should be a Microsoft Windows account that has access to SQL Server and has network access.

- **EDA_SVC_PASSWORD** - Password to use for the Early Data Analyzer service. User name and password should be a Microsoft Windows account that has access to SQL Server and has network access.

- **LAW_CASE_DIRECTORY** - Default case directory for LAW PreDiscovery and Early
Data Analyzer cases.
In LAW PreDiscovery, the default case directory is C:\Program Files (x86)\Law50\Cases\.
If the directory for a case has spaces in it, the directory must be wrapped in quotes.
For example, <installer>.exe /s /v"/qn ADDLOCAL=LawPreDiscovery
LAW_CASE_DIRECTORY="C:\LAW Cases""

- **LAW_IMAGE_DIRECTORY** - Default image directory for LAW PreDiscovery cases.
  In LAW PreDiscovery, the default image directory is C:\Program Files (x86)\Law50\Cases\.
  If the directory for an image has spaces in it, the directory must be wrapped in quotes.
  For example, <installer>.exe /s /v"/qn ADDLOCAL=LawPreDiscovery
  LAW_IMAGE_DIRECTORY="C:\LAW Cases\Images"

- **LAW_LICENSE_SERVER** - License server name for LAW PreDiscovery. For a local license server, use LOCALHOST. For network server, use the network server's full computer name.
- **LAW_SHARED_SETTINGS** - Shared settings directory for LAW PreDiscovery.
  In LAW PreDiscovery, the default shared settings directory is C:\Program Files (x86)\Law50\Shared2\.
- **LAW_SQL_SERVER** - SQL Server for LAW PreDiscovery. Use the SQL Server instance name for LAW PreDiscovery and Early Data Analyzer.
- **LAW_SQL_INTEGRATED_SECURITY** - determines whether Windows integrated security is used for SQL Server.
  
  Available Values:
  - **1** - Enables Windows integrated security
  - **0** - Disables Windows integrated security

For example: ADDLOCAL=<features> EDA_SVC_AS_USER=1
EDA_SVC_USERNAME=NameUser EDA_SVC_PASSWORD=password

7. Press ENTER to run the silent installation on the machine.

Here is an example of a LAW PreDiscovery silent installation command:

```bash
law_full_6.10.0.exe /s /v"/qn ADDLOCAL=LawPreDiscovery,Printers,EarlyDataAnalyzer EDA_SVC_AS_USER=1
EDA_SVC_USERNAME=NameUser EDA_SVC_PASSWORD=password"
```

In this example, the silent installation uses the LAW PreDiscovery 6.10.0 version of in the installation .exe file, and installs LAW PreDiscovery with the TIFF and PDF print drivers and Early Data Analyzer, and Early Data Analyzer will use a specific user for the Early
Data Analyzer service. The command also provides the user name and password for the Microsoft Windows account used for the Early Data Analyzer service.

Related Topics

License Manager
LAW Profile Manager
Configuring LAW and SQL Server

License Manager

The License Manager is installed on the license server for LAW PreDiscovery and LexisNexis® Early Data Analyzer. The License Manager is used exclusively for software key licensing, and is used to activate, refresh, and deactivate the software product keys hosted on the license server. The licenses and license seats for the activated software product keys on a license server can be monitored from the License Manager. You can also monitor the licenses and license seats for the activated software product keys on the current license server from the LAW Profile Manager.

You cannot view the license information for temporary licenses in the License Manager dialog box.

You can only view license information for the software product keys activated on the license server in the License Manager dialog box.
Please note that machine specifics of the computer/server hosting the license is used in generating the authorization for licensing. If you are planning to make changes to your license server that would affect the machine's unique identifiers, then please contact LAW PreDiscovery Support to assist with the license transfer prior to making the changes to avoid any disruption of service.

Currently virtual machines set to auto migration in cluster environments are not supported because it will change the machine unique identifiers and will invalidate the license server. For cluster environments it is recommend that you turn off auto migration on the virtual machine, that is the license server, to avoid any disruption of service.

To activate a software product key

Unless you are manually activating a software product key, you will need an Internet connection to activate a software product key in the License Manager.
1. Open the **License Manager** on the license server.

   To open the **License Manager**, click **Start menu > All Programs > LAW PreDiscovery > License Manager**.

2. Click the **Activations** button.

   Clicking the **Activations** button opens the **Activations** dialog box.

   Any software product keys already activated on the license server are displayed, along with the date and time each software product key was activated, in the **Activated licenses** list.

3. In the **Product Key** field, enter the software product key provided by LexisNexis.

4. Click **Activate**.

   Clicking **Activate** activates the software product key, and the **Product key successfully activated** message is displayed.

5. Click **OK** to close the message and **Activations** dialog box and return to the **License Manager** dialog box.

   The **License Manager** displays the LAW PreDiscovery and/or Early Data Analyzer license information from the activated software product key(s). If more than one software product key is activated on the license server, the **License Manager** displays the combined license information from each of the software product keys currently activated on the license server.
To activate product keys using the command line utility

If you need to automate license activation for large scale automated deployments, you can use the command line utility to activate product keys.

You must have an internet connection to activate product keys using the command line utility.

1. To open the command line utility, click Start, type "Command Prompt", and press Enter.

2. In the command line utility, enter the following to activate a product key:

   LicenseConsole.exe /Activate=<Product Key>

To activate license files using the command line utility

If you need to automate license activation for large scale automated deployments, you can use the command line utility to activate license files.

1. To open the command line utility, click Start, type "Command Prompt", and press Enter.

2. In the command line utility, enter the following to activate a license file:

   LicenseConsole.exe /ActivationFile=<File>

To manually activate a software product key

If you need to activate a software product key, but do not currently have an Internet connection on the license server where the License Manager is installed, you can manually activate the software product key.

To manually activate a software product key, you will need to contact the LAW PreDiscovery Technical Support team, provide them with the software product key and the machine ID for the license server, then the Technical Support team will generate and send you a license code file for activating the software product key on the license server. You can locate the machine ID you will need to provide the Technical Support team in the Manual Activation dialog box.

1. Open the License Manager on the license server.

   To open the License Manager, click Start menu > All Programs > LAW PreDiscovery > License Manager.

2. Click Activations.

   Clicking Activations opens the Activations dialog box.
3. Click the **Manual Activation** link.

Clicking the **Manual Activation** link opens the **Manual Activation** dialog box.

The **Machine Id** box displays the machine ID for the license server.
If you need to copy the machine ID, click the Copy link.

4. Have your software product key and your machine ID ready, and then contact LAW PreDiscovery Technical Support at 1-800-833-3346. Choose option 5 for LAW PreDiscovery.

   The Technical Support team will generate and provide you with a license code file.

5. Save the license code file to the license server where you will be activating the software product key.

6. In the Manual Activation dialog box, click the ellipsis button, …, next to the License File box.

7. Clicking the ellipsis button, …, opens the Select license file to activate dialog box.

   ![Select license file to activate dialog box]

8. Navigate to and click the license code file.

9. Click Open.

   Clicking Open adds the license code file and path to the License File field.

10. Click Activate.

    Clicking Activate opens the License(s) activated message.

11. Click OK.

    The License Manager displays the LAW PreDiscovery and/or Early Data Analyzer license information from the activated software product key. If more than one software product key is activated on the license server, the License Manager displays the combined license information from each of the software product keys currently activated on the license server.
To view the license information for another license server

The License Server field in the License Manager dialog box indicates which license server license information is currently being displayed in the License Manager dialog box. The License Server field in the License Manager dialog box does not determine which license server is being used by LAW PreDiscovery and Early Data Analyzer.

The Change License Server dialog box in the LAW Profile Manager determines which license server is used for LAW PreDiscovery. The License Server field in the Configure Environment dialog box in Early Data Analyzer determines which license server is used for Early Data Analyzer and DiscoveryIQ.

1. Open the **License Manager** on the license server.
   
   To open the **License Manager**, click **Start menu > All Programs > LAW PreDiscovery > License Manager**.

2. Click the **License Server** field link.
   
   Clicking the **License Server** field link opens the **Set License Server** dialog box.

3. In the **License Server** field, enter the machine name or IP address of the license server containing the software product key information you want to view.

4. Click **OK**.
   
   If you entered a valid license server, clicking **OK** opens the **License server successfully set** message.

5. Click **OK**.
   
   The license server you entered is displayed in the **License Server** field, and the license information for the software product key(s) currently activated on the license server is displayed in the **License Manager** dialog box.

To view the list of activated software product keys

© 2018 LexisNexis. All rights reserved.
There are two places you can view the list of activated software product keys on a license server:

- **License Manager.** The Activated licenses list in the Activations dialog box displays every software product key currently activated on the license server and the date and time each software product key was activated.

- **DataStore.xml file.** When software product keys are activated in the License Manager, all activated software product keys on the license server and the local dates and times the software product keys were activated are stored in the DataStore.xml file in the following directory on the license server:

  C:\ProgramData\LexisNexis\Litigation License Manager

The DataStore.xml file is automatically updated with the latest software product key activation information from the License Manager.

To update a software product key

If changes have been made to your software product key, such as adding additional licenses or renewing the software product key, you can update your software product key by clicking the Refresh button in the Activations dialog box. When the Refresh button is clicked, the License Manager contacts the LexisNexis servers over the Internet to get the latest updates for your software product key(s). An active Internet connection is required to update software product keys using the Refresh button.

1. Open the **License Manager** on the license server.
   
   To open the License Manager, click Start menu > All Programs > LAW PreDiscovery > License Manager.

2. Click **Activations**.
   
   Clicking Activations opens the Activations dialog box.

3. In the **Activated licenses** list, click the software product key you want to update.

4. Click **Refresh**.
   
   When the software product key update is completed, the message License successfully refreshed. is displayed.

5. Click **OK** to close the message.

6. In the Activations dialog box, click the close button, , to return to the License Manager dialog box.

7. In the License Manager dialog box, click the **Refresh** link above the Expiration column
to display the latest license information.

To deactivate a software product key

Software product keys can be deactivated from the Activations dialog box in the License Manager. A software product key needs to be deactivated if you need to move the software product key from one machine to another. Deactivating a software product key on the machine where it is currently activated makes it available for activation on another machine.

1. Open the License Manager on the license server.

   To open the License Manager, click Start menu > All Programs > LAW PreDiscovery > License Manager.

2. Click Activations.

   Clicking Activations opens the Activations dialog box.

3. In the Activated licenses list, click the software product key you want to deactivate.

4. Click Deactivate.

   When the software product key deactivation is completed, the message License successfully deactivated. is displayed.

5. Click OK to close the message.

6. In the Activations dialog box, click the close button, , to return to the License Manager dialog box.

7. In the License Manager dialog box, click the Refresh link above the Expiration column to display the latest license information.

   When a software product key is deactivated, the software product key is removed from the Activated licenses list in the Activations dialog box, and the license seats contained in the software product key are removed from the license list in the License Manager dialog box.

To refresh the license list in the License Manager

The license information displayed in the License Manager dialog box is automatically refreshed each time you open the dialog box or when you leave and return to the dialog box, such as when you activate a software product key.

You can also refresh the license information currently displayed in the License Manager dialog box by clicking the Refresh link located above the Expiration column.
The LAW Profile Manager is the utility used for managing licenses. The licensing type you are using for LAW PreDiscovery determines which functionality is available in the LAW Profile Manager.

All licenses are maintained in a software product key on the license server. A license server is where a software product key is activated on the computer.

You can use the LAW Profile Manager to perform the following tasks:

- Connect to a license server for LAW PreDiscovery
- Add, edit, and delete custom license profiles for LAW PreDiscovery
- Monitor usage and availability of licenses
- Enter a temporary license key for LAW PreDiscovery

**To start the LAW Profile Manager**

- Click Start, point to All Programs, point to LAW PreDiscovery, and then click Profile Manager.

**To create or change a password**

To create a password for the first time on a computer:

1. Click Start, point to All Programs, point to LAW PreDiscovery, and then click Profile Manager.
2. Click Advanced.
   
   A prompt to enter an administrative password appears. The password is stored at a workstation level, meaning each computer on which LAW PreDiscovery is launched, whether running locally or in a client/server configuration, will prompt for a password when executed initially.
3. In the Enter Admin Password dialog box, type a case-sensitive password that is at least 6 characters long and then type it again to confirm.
4. Click OK.
To change the password on a computer:

1. Click **Start**, point to **All Programs**, point to **LAW PreDiscovery**, and then click **Profile Manager**.

2. Click **Advanced**.

   If you are not in administrative mode, the **Enter Password** dialog box appears.

3. Type the current administrative password and then click **OK**.

   Clicking **OK** opens the **Successfully switched to administrative mode.** message.

4. Click **OK**.

5. On the **Tools** menu, click **Change Administrative Password**.

   Clicking **Change Administrative Password** opens the **Change Admin Password** dialog box.

6. In the **Enter new password** field, type a case-sensitive password that is at least 6 characters long, and then type it again in the **Confirm Password** field.

7. Click **OK**.

   A prompt for a password after clicking **Advanced** means that you are not running the LAW Profile Manager in administrative mode. For more information, see the **To switch to Administrative Mode** section in this topic.

To use a temporary license in LAW PreDiscovery

If you were issued a temporary LAW PreDiscovery license key, you can enter the license key in the Change License Server dialog box to access LAW PreDiscovery.

Once you obtain a full LAW PreDiscovery license key, you can connect to your license server from the Change License Server dialog box. For more information, see **To connect to a license server** in this topic.

1. When you start LAW PreDiscovery for the first time on a computer, the **Change License Server** dialog box appears.
If the LAW Profile Manager dialog opens instead of the Change License Server dialog box, in the LAW Profile Manager dialog box, click the ellipses button, ..., to open the Change License Server dialog box.

2. In the Change License Server dialog box, type Temp:[temporary license key number].

3. Click OK.

If a valid temporary license key has been entered, the following message is displayed:

The license was successfully changed to '[temporary license key number]'
The temporary license will expire on 'dd/mm/yyyy'

4. Click **OK**.

Clicking **OK** opens LAW PreDiscovery.

The temporary license key you entered is stored in the law50.ini file located in the ...
\Program Files (x86)\LAW50 folder.

When a temporary license is in use, the **LAW Profile Manager** dialog box is not displayed when starting the LAW PreDiscovery application.

**To connect to a license server**

1. When you start LAW PreDiscovery for the first time on a computer, the **Change License Server** dialog box appears.

![Change License Server dialog box]

If the **LAW Profile Manager** dialog opens instead of the **Change License Server** dialog box, in the **LAW Profile Manage** dialog box, click the ellipses button, ..., to open the **Change License Server** dialog box.
2. In the **Change License Server** dialog box, type the computer name of the computer serving as the license server for LAW PreDiscovery.

   If you are using software key licensing, the license server is the computer where the software product key(s) used by LAW PreDiscovery is activated.

   If the software product key is activated on the computer where you are currently working, type **LOCALHOST**.

   If the software product key is activated on a different computer, type the name of that computer.

   To find the name of a computer, click **Start**, right-click **Computer**, and then click **Properties**. The computer name appears in the **Computer name** and **Full computer name** fields.

3. Click **OK**.

   If a valid license server computer name has been entered, the **LAW Profile Manager** dialog box opens.

   If a license key is not found on the specified server, a message will appear stating that the key was not found and will ask to try another server. If this happens click **Yes**, and then follow the prompts to change the license server.

**To select licenses by using a license profile**

Each time you start LAW PreDiscovery, instead of selecting licenses singly, you can load a
1. Start the LAW Profile Manager.

2. Check out licenses by means of a license profile by selecting one of the following:
   - **<Any Available Licenses>** Checks out one of each available license. These licenses will not be available to other workstations using the same license key.
   - **<Custom>** You can check out specific licenses based on their tasks. For example, if you need to scan documents, you can select just the Scan license. Click **OK** to open the list of licenses.
   - **User defined.** Any user-defined license profile is listed below the two system profiles. To create a user-defined license profile, see the **To create custom profiles** section in this topic.

3. Select the licenses needed for the session and then click **OK**.

   Only the selected licenses are checked out and available on that workstation. If one or more license modules cannot be checked out, a message box appears stating which licenses could not be acquired. This message will not appear if the CD Publishing license could not be acquired.

**To create custom profiles**

1. Start the LAW Profile Manager.
2. Click **Add**.

   If the **Add** button is grayed out, switch to administrative mode to enable it. On the **File** menu, click **Switch to Administrative Mode** and then enter and confirm the password, click **OK** twice and then click **Add**.

3. In the **Add New Profile** dialog box type the name of the new profile and a description.

4. Select the licenses to include in the profile.

5. To set this profile as the default profile for the current user, select **Default Profile**.

6. Click **OK**.

   The new license profile is displayed in the **LAW Profile Manager** dialog box. If selected as the default profile, it is automatically highlighted.

7. To automatically check out licenses and bypass the LAW Profile Manager, select the profile as the default profile. Then deselect **Prompt for profile when starting LAW** in the **LAW Profile Manager** dialog box.

   To re-enable the setting that automatically opens the LAW Profile Manager, set **Prompt=1** in the `profman.ini` file in `<application path>\ProfMan`. The section in the INI file containing this setting is in the following format: `[<user name>]`.

---

**To hide the system profiles**

Hiding a profile can be useful to safeguard against inadvertently selecting the wrong profile. For example, the LAW Profile Manager populates the Profiles area with two system profiles `<Any Available Licenses>`, and `<Custom>`. To prevent users from checking out more licenses than needed, these profiles may be hidden.

1. Start the LAW Profile Manager.

2. Click **File**, and then click **Switch to Administrative Mode**. Enter the administrative password, click **OK**, and then **OK** again.

3. Right-click the system profile to hide and then click **Hide System Profile**.

---

**To restore the system profiles**

- Right-click anywhere in the **Profile** area and then click **Restore Hidden Profiles**.

---

**About Administrative Mode**

You must switch the LAW Profile Manager to administrative mode before you can perform several administrative functions, such as working with licenses and working with profiles.

One way to switch to administrative mode is to start the LAW Profile Manager, and then, on the **File** menu, click **Switch to Administrative Mode** and then type the administrator password. Alternatively, there are many features that require you to provide the administrator password before continuing. Switching to administrative mode enables you...
to:
- Add, edit, and delete profiles.
- Refresh licenses to add any newly purchased licenses to the software product key.
- Enter the advanced view of the LAW Profile Manager.
- Hide/restore system profiles.

To switch to Administrative Mode

1. Click **Start**, point to **All Programs**, point to **LAW PreDiscovery**, and then click **Profile Manager**.

   The **LAW Profile Manager** dialog box appears.

2. Click **File** and then click **Switch to Administrative Mode**.

   The **Enter Password** dialog box appears.
3. Type the administrative password and then click OK.

Clicking OK opens the Successfully switched to administrative mode. message.

4. Click OK.

To configure administrative details

1. Click File and then click Switch to Administrative Mode.
2. The **Enter Password** dialog box appears.
3. Type the administrative password and then click **OK**.
   
   Clicking **OK** opens the *Successfully switched to administrative mode.* message.

4. Click **OK**.

5. Click **Advanced**.
   
   The LAW Profile Manager searches for the license servers.
   
   The **LAW Profile Manager (Administrative Mode)** dialog box appears.
6. Use the following menu commands to configure the administrative mode of the LAW Profile Manager:

<table>
<thead>
<tr>
<th>Use the</th>
<th>When you want to</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File menu</strong></td>
<td>• Refresh the view of profiles.</td>
</tr>
<tr>
<td></td>
<td>• Refresh the view of available license servers.</td>
</tr>
<tr>
<td><strong>Profile menu</strong></td>
<td>• Add, edit, and delete profiles.</td>
</tr>
<tr>
<td></td>
<td>• Set a profile as the default.</td>
</tr>
<tr>
<td><strong>Server Key menu</strong></td>
<td>• Change the license server.</td>
</tr>
<tr>
<td></td>
<td>• Refresh the view of license counts when new licenses have been purchased and added to the existing software product key.</td>
</tr>
<tr>
<td><strong>Tools menu</strong></td>
<td>• Change the administrative password.</td>
</tr>
<tr>
<td></td>
<td>• Disable or enable automatic refresh of the view of network server keys. This option is controlled by the Enable LAW PreDiscovery license server enumeration setting, which is enabled by default.</td>
</tr>
<tr>
<td><strong>Profiles tree</strong></td>
<td>• Add, edit, and delete custom profiles.</td>
</tr>
</tbody>
</table>
• View details about all profiles stored on the current computer, as well as the two default license selection methods (<Any Available License> and <Custom>). When a profile is selected, the right pane will display the name, description, and licenses stored in that particular profile.

**License Servers tree**

View details about the current license server.

Software License is displayed under **License Servers** and the license server's computer name is displayed under **Software License**.

The LAW Profile Manager columns provide the following information:

- **License.** Lists each type of LAW PreDiscovery license.
  
  Licenses that do not exist on the product key are listed, but 0 is displayed in the Total, In Use, and Free columns for the license.

- **Total.** Displays the total number license seats for each type of license.

- **In Use.** Displays the number of license seats in use for each type of license.

- **Free.** Displays the number of available license seats for each type of license.

---

**About concurrent user licenses (Hardware Key licensing only)**

Concurrent user licenses are only available with hardware key licensing.

The total number of user licenses controls the total number of users that may work concurrently in LAW PreDiscovery and/or Early Data Analyzer. Concurrent licensing means that users can run LAW PreDiscovery and/or Early Data Analyzer using any combination of licenses, at the same time. For example, if a key contains 10 concurrent user licenses, and 3 workstations are currently logged into LAW PreDiscovery, then 7 concurrent user licenses will be available at that time.

In the License Servers tree, the serial number of the license server key is listed with two numbers in parentheses beside it. These two numbers reflect concurrent user license counts.

The first number indicates the number of concurrent licenses in use.

The second number indicates the total number of concurrent licenses contained on the server key.

For example, the '5' in (5/20) means that LAW PreDiscovery is running on 5 computers. The '20' means that there is a total of 20 concurrent licenses on the key. In this example, you could conclude that concurrent user licenses are still available.

The amount of concurrent user licenses that you may work with depends on a number of factors. If more are needed, contact LexisNexis.
To Add new licenses to an existing Server Key (Hardware Key licensing only)

The Refresh License(s) from Internet feature in the LAW Profile Manager is only available with hardware key licensing. The instructions in this procedure apply only after you have purchased additional licenses from LexisNexis sales and a sales representative has updated the license counts.

1. Log in to a computer designated as a license server.
2. Start the the LAW Profile Manager.
3. Click File and then click Switch to Administrative Mode.
   - File menu in the LAW Profile Manager dialog box
   - The Enter Password dialog box appears.
4. Type the administrative password and then click OK.
   - Clicking OK opens the Successfully switched to administrative mode message.
5. Click OK.
6. On the File menu click Refresh License(s) from Internet.
   - The key will be updated with the new license counts.

To acquire or release licenses from LAW PreDiscovery

To avoid closing LAW PreDiscovery and launching the LAW Profile Manager in order to change the selection of license modules, licenses can be checked out and released from within the LAW PreDiscovery application.

1. In LAW PreDiscovery on the Help menu, click About LAW, and then click Licenses.
   - The License Information dialog box appears.
In the **Active Key** area, the **Server Name** field displays the license server name. The **Serial No.** field displays SOFTWARE LICENSE for software key licensing and the product key expiration date(s) (if applicable).

The **Licenses** area displays the LAW PreDiscovery licenses. When a license's check box is selected, it means the license is currently checked out. If a license name is grayed out, the product key does not contain this license.

2. Perform one of the following:
   - To acquire a license, select the license's check box. A message box will appear indicating whether license acquisition was successful.
   - To release a license, clear the license's check box. No message box will appear.

   - **At least one license must remain checked out while LAW PreDiscovery is running.**
   - **If the OCR license is released, OCR Add-on (PDF) will be automatically released because it also depends on the OCR license.**
Undocked Keys

When using hardware key licensing, the software licenses needed to run LAW PreDiscovery and LexisNexis® Early Data Analyzer are provided on encrypted Sentinel USB keys, called license keys. LexisNexis can also provide encrypted USB keys that do not contain licenses. These are called undocked license keys. The purpose of an undocked license key is to temporarily hold licenses checked out from the license key, so that licenses can be used on a second computer. A typical use of undocked keys is to furnish a laptop with the licenses necessary to conduct onsite discovery operations.

Undocked license keys are generated from the LAW Profile Manager, where you specify which licenses to checkout and the length of time to check them out. When the licenses are ready to be returned to the original license key, the licenses are reclaimed from the LAW Profile Manager using the Reclaim Undocked Key(s) menu selection. For more information about the LAW Profile Manager, see LAW Profile Manager.

Sentinel USB license keys, undocked license keys, and the functionality for generating and reclaiming undocked license keys in the LAW Profile Manager are only available with hardware key licensing. For more information about licensing, see About Licensing.

To obtain undocked keys

There are two sources of undocked keys:
- Undocked keys can be purchased from LexisNexis. For more information you can
- LAW PreDiscovery 4.0 license keys and Z-Print keys can be reused as undocked keys after upgrading to LAW PreDiscovery 5.0 or above.

- Soft License keys cannot be used as undocked keys.

To create an undocked key on a local server
1. Plug an undocked USB key into the LAW PreDiscovery license server.

2. Click **Start**, point to **All Programs**, point to **LAW PreDiscovery**, and then click **Profile Manager**.

   The **LAW Profile Manager** dialog box opens.

3. On the **File** menu, click **Switch to Administrative Mode**, and then type the administrator password.

4. Click **OK**.

   Clicking **OK** opens the *Successfully switched to administrative mode.* message.

5. Click **OK**.

6. On the **Tools** menu, click **Options**, and then clear the **Enable LAW PreDiscovery license server enumeration** check box, if it is already selected.

7. Click **OK**.

8. On the **File** menu, click **Undocked Key Admin**, and then click **Create Undocked Key**.

9. Do one of the following, depending on how many license keys are plugged into the local computer, not counting the undocked key:

   - If more than one license key is plugged into the local computer, you will see the **Select License Key** dialog box, which lists the license keys plugged into the computer. Select a license key and then click **OK**. The **Select Licenses** dialog box opens.
Or

- If just one license key is plugged in, the Select Licenses dialog box opens immediately.

10. Select licenses to check out, select an expiration date, and then click OK.

The Undock Successful confirmation box opens.

11. Click OK.

The undocked key may be detached from the current workstation and used on a different LAW PreDiscovery workstation.

To create an undocked key on a local server (alternative method)

1. Plug an undocked USB key into the LAW PreDiscovery license server.

2. Click Start, point to All Programs, point to LAW PreDiscovery, and then click Profile
Manager.

The LAW Profile Manager dialog box opens.

3. On the File menu, click Switch to Administrative mode, and then type the administrator password.

4. Click OK.

Clicking OK opens the Successfully switched to administrative mode. message.

5. Click OK.

6. On the Tools menu, click Options, and then clear the Enable LAW PreDiscovery license server enumeration check box, if it is already selected.

7. Click OK.

8. Click Advanced, type the administrator password, and then click OK.

The LAW Profile Manager (Administrative Mode) dialog box opens.

9. Select a key.

Licenses held on the selected key are listed. Licenses showing 1 or higher in the Free column are available for checkout.
10. On the **Server Key** menu, click **Create Undocked Key**.

The **Select Licenses** dialog box appears.
11. Select licenses to check out, select an expiration date, and then click **OK**.

   The **Undock Successful** confirmation box opens.

   ![Undock Successful](image)

12. Click **OK**.

   The newly created undocked key appears below the key. The undocked key may be detached from the current workstation and used on a different LAW PreDiscovery workstation.

13. Optionally, click the undocked key.

   License key details are visible, including key serial number, key type, check-out date, expiration date, and the names of checked out licenses.

<table>
<thead>
<tr>
<th>Serial No.</th>
<th>Type</th>
<th>Check-Out</th>
<th>Expiration</th>
</tr>
</thead>
<tbody>
<tr>
<td>License(s):</td>
<td>Electronic Dis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

   ![Profiles](image)

---

**To reclaim undocked keys**

1. Plug the undocked USB key into the LAW PreDiscovery license server.

2. Click **Start**, point to **All Programs**, point to **LAW PreDiscovery**, and then click **Profile Manager**.

   The **LAW Profile Manager** dialog box opens.
3. On the **File** menu click **Switch to Administrative Mode**, and then enter the administrator password.

4. Click **OK**.

5. On the **Tools** menu, click **Options**, and then clear the **Enable LAW PreDiscovery license server enumeration** check box, if it is already selected.

6. Click **OK**.

7. On the **File** menu, click **Undocked Key Admin**, and then click **Reclaim Undocked Key(s)**.

8. In the **Reclaim Successful** confirmation, click **OK**.

LAW PreDiscovery reclaims all licenses on the undocked key and returns them to the server key.

To view properties of a local server, keys, and undocked keys

1. Click **Start**, point to **All Programs**, point to **LAW PreDiscovery**, and then click **Profile Manager**.

The **LAW Profile Manager** dialog box opens.
2. On the **File** menu click **Switch to Administrative Mode**, and then enter the administrator password.

3. Click **OK**.

4. On the **Tools** menu, click **Options**, and then clear the **Enable LAW PreDiscovery license server enumeration** check box, if it is already selected.

5. Click **OK**.

6. Click **Advanced**, type the administrator password, and then click **OK**.

   The **LAW Profile Manager** dialog box opens in administrative mode. The license servers are shown with license keys and any undocked keys.
7. Select license servers, keys, and undocked keys to view the details of each, as described in the following table:

<table>
<thead>
<tr>
<th>Click this:</th>
<th>To view these details:</th>
</tr>
</thead>
<tbody>
<tr>
<td>License server</td>
<td>• Server name</td>
</tr>
<tr>
<td></td>
<td>• IP address</td>
</tr>
<tr>
<td></td>
<td>• Key count</td>
</tr>
</tbody>
</table>

| Keys              | • License types contained on the key                       |
|                   | • Total of each type of license                            |
|                   | • Number of each type in use                               |
|                   | • Number of each type available                            |
Undocked keys

- Key serial number
- Type (public or private)
- Check-out date
- Expiration date
- Names of any checked out licenses, for example Electronic Discovery: Loader

Related Topics

LAW Profile Manager
License Matrix
Installing LAW PreDiscovery

User Guide
Using LAW PreDiscovery

**Acquiring Documents**

You use LAW PreDiscovery to acquire documents in any of several ways: through electronic discovery, via scanner, or by directly importing cases, load files, or raw images.

**Importing Electronic Discovery**

You use the Electronic Discovery Loader (ED Loader) utility to import electronic documents.

**ED Loader Settings Prior to importing**

Before importing into LAW PreDiscovery through ED Loader, it is necessary to configure your Outlook correctly.

- **Office 365 Desktop Installation**
  
  Office 365 functions similar to Office 2016 except that there is a cloud/virtual version and a desktop installed version. For functionality with LAW PreDiscovery the desktop version needs to be installed. Please see Microsoft’s website on how to confirm if you have the installed version of Office 365. What *Office 365 business product or license do I have?* Please contact Microsoft support for any questions in regards to their licensing.

  If you have Office 365 32-bit desktop version installed then the Outlook configuration is the same as Outlook 2016. Office 365 64-bit desktop version is not supported.

- **Setting up a dummy Outlook profile**

  - **Outlook 2016**
    
    1. Close completely out of Law PreDiscovery and Microsoft Outlook.
    2. Go to Windows Control Panel > Mail *(Microsoft Outlook 2016) (32-bit)*
    3. Select *Show Profiles*
4. Select **Add**, type in an underscore for the profile name, then hit **OK**.

5. Deselect **Set up Outlook Mobile on my phone, too**, then select **Connect to a different account**.
Connect Outlook to Office 365
Powerful tools for managing email, calendar, contacts, and tasks.

6. Select **Manual setup** or **additional server types**, then **Next**.

7. Select **Pop** or **IMAP**, then **Next**.
8. Fill in the highlighted values with an underscore except for Email Address which will be: _@_.com
9. Deselect **Automatically test account settings when Next is clicked**.

10. Deselect **Remember password**, then select **Next**.
11. Deselect **Set up Outlook Mobile on my phone, too**, then choose **Finish**.
12. The last step is to select *Always use this profile*, your new profile, and **OK**.

### Outlook 2013

1. Close completely out of Law PreDiscovery and Microsoft Outlook.
2. Go to Windows Control Panel > Mail
3. Select **Show Profiles**
4. Select **Add**, type in an underscore for the profile name, then hit **OK**.

5. Select **Manual setup or additional server types**, then **Next**.
6. Select **Pop or IMAP**, then **Next**.
7. Fill in the highlighted values with an underscore except for Email Address which will be: _@_.com

8. Deselect **Automatically test account settings when Next is clicked**.

9. Deselect **Remember password**, then select **Next**.

10. Then choose **Finish**.

11. The last step is to select **Always use this profile**, your new profile, and **OK**.
1. Close completely out of Law PreDiscovery and Microsoft Outlook.
2. Go to Windows Control Panel > Mail
3. Select **Show Profiles**
4. Select **Add**

5. Type in an underscore for the profile name, then select **OK**.
6. Select **Manually configure server settings**, then **Next**.

7. Select **Internet E-mail** or POP3 as the e-mail service, then **Next**.
8. Put an underscore in all fields except E-mail Address and Password. Type "_@_.com" in E-mail Address and leave Password blank. De-select Test Account Settings, then Next.
9. Select **Finish**, then select the newly created dummy profile under **Always use this profile**.

10. Then select **OK**.

**Outlook Version Limitations**

<table>
<thead>
<tr>
<th>Outlook Version</th>
<th>PST size limitations for processing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outlook 2007</td>
<td>Maximum pst size of 20 GB</td>
</tr>
<tr>
<td>Outlook 2010</td>
<td>Maximum pst size of 50 GB</td>
</tr>
<tr>
<td>Outlook 2013</td>
<td>Maximum pst size of 50 GB</td>
</tr>
<tr>
<td>Outlook 2016</td>
<td>Maximum pst size of 50 GB</td>
</tr>
</tbody>
</table>

⚠️ The maximum pst size for Outlook 2010 and higher can be adjusted in the registry to exceed the above limits. This registry item should be performed on all machines involved in the ED Loader processing (distributed process). [Microsoft’s Knowledge Base](https://support.microsoft.com/en-us)
Configuring Import Settings

ED Loader provides general configuration options as well as options that are specific to the type of source you are importing.

In version 6.17.96+ you can configure ED Loader to use passwords for processing encrypted files. The Passwords tab allows you to enter any known passwords for password-protected Adobe Acrobat PDF, office files (ex. PPT, PPTX, DOC, DOCX, XLS and XLSX files), Pkzip, Zipx and 7zip files.

- ED Loader passwords will temporarily decrypt the previously mentioned file types and extract both metadata and content from the protected documents.

- Passwords are global. You have one list of passwords for all LAW PreDiscovery databases on that computer. If you are working in Case A, add passwords, and switch to Case B; then you will see the same password list in Case B. See Sharing the password list across multiple computers.

- If you are imaging the encrypted files then you will need to enter the passwords again in your Tiff settings.

- The encrypted files will remain encrypted when exported.

To access and configure your passwords for office and pdf files

1. On the File menu click Import and then click Electronic Discovery.
2. Click the Settings tab and then click Password.
All passwords are case sensitive without character limitations.

To Add a password.
1. Enter the password in the box under Current.
2. Then select Add.
3. Repeat the process for as many passwords as needed.

To Update a password.
1. Select the password that you need to correct under Passwords(#).
2. Then edit the password in the Current box.
3. Select Update when your changes are complete.
To Delete a password.

1. Select the password that you need to delete under Passwords(#).
2. Then select Delete.
3. You will then get a prompt, "Are you certain you want to delete the selected password?"

4. Select **Yes** and the selected password will be removed from the list.

5. Selecting **No** will bring you back to the Password screen without deleting the password.

   - **To Delete all passwords.**

   1. Select **Clear All.**
2. You will then get a prompt, "Are you certain you want to delete all passwords?"

3. Select Yes and all passwords will be removed from the list.
4. Selecting No will bring you back to the Password screen without deleting the passwords.

**Sharing the password list across multiple computers.**

1. Close LAW PreDiscovery.
2. Open a File Explorer window.
3. Browse to C:\Program Files (x86)\LAW50\EDLoader.

When using LAW PreDiscovery with UAC (User Account Control) enabled, the LAW50 folder may be redirected to the virtual store. The virtual store is located in the profile of the current user, for example:

C:\Users\<User>\AppData\Local\VirtualStore\Program Files (x86)\Law50\EDLoader.

4. Copy the edloader.pwdfile.txt file.
5. Browse out to a location on the network that all computers can access for example the network share where cases are stored.
6. Paste the edloader.pwdfile.txt file to the above location.
7. Copy the UNC path of the new location for the edloader.pwdfile.txt.
8. Launch LAW PreDiscovery.
9. Open the case/database.
10. Go to File>Import>Electronic Discovery>Settings>Passwords.

11. Select the ellipses next to the original path.
12. Paste the path from step 7 into the file browser that is open.
13. Select edloader.pwdfile.txt.
14. Select Open.
15. The path has now been changed for this computer. Repeat the above process from step 7 for other computers on your network.
If you add a new computer, or uninstall LAW, then you will need to repeat the above process for the new or reinstall of LAW PreDiscovery.

By default, if the password is configured on this computer and a distributed import is ran, then the passwords loaded here will be utilized on all computers involved in the distributed import.

This feature can be used with the Reprocessing Failed Items feature for files from prior imports (imports using version 6.15.083+) that failed due to password encryption.

Reprocessing Failed Items in Electronic Discovery Feature introduced in Version 6.15.83+

This feature will enable reprocessing of records that had one of the following errors during prior Electronic Discovery sessions: Write failed, Attachment Extraction failed, Embedded Image Extraction failed, and/or Compound Doc. Extraction failed.

How to determine whether to process Failed Items

Different scenarios and Reprocess behaviors
• Password protected compound document
  The compound document will be copied to the reprocess folder ($Repository$Files) for reprocessing.

• Password protected archive
  The archive document will be copied to the reprocess folder for reprocessing.

• Archive contains password protected document with “Treat archive as attachment container” option selected
  The parent archive is logged into Law successfully
  The password protected document will be copied to the reprocess folder for reprocessing.

• Archive contains password protected document without “Treat archive as attachment container” option
  The parent archive is not logged into Law
  The password protected document will be copied to the reprocess folder for reprocessing.

• Archive embedded with password protected archive with “Treat archive as attachment container” and “Include embedded archive” options
  The parent archive is logged into Law successfully.
  The embedded password protected archive will be copied to the reprocess folder for reprocessing.

• Archive embedded with password protected archive with “Treat archive as attachment container” option and without “Include embedded archive” option
  Only the parent archive is logged into Law successfully.

• Password protected archive embedded with another archive with “Treat archive as attachment container” and “Include embedded archive” options
  The password protected archive will be copied to the reprocess folder for reprocessing.

• Archive embedded within email item.
  The parent archive and email item is imported into Law successfully.
  The password protected document will be copied to the reprocess folder for reprocessing.

• Emails with password protected attachments
  The parent document (Email) is processed successfully.
  The password protected attachment(s) will be placed into the reprocess folder for reprocessing.

You can determine if reprocessing is needed by either checking your prior ED Loader Session Logs for processing errors/warnings or select the Failed Items tab.

☐ To Check the ED Loader Session Logs for processing errors/warnings

1. Review the Session Log by opening the Session Viewer. For more information on the Session Viewer, see: Session Browser and Session Viewer.

   • Look for records listed in the Incomplete or Commit tabs.

   • If records are listed in either of these tabs, they were not imported.

   • Records appearing in the Incomplete tab might be able to be resolved by resuming the ED Loader session. If this does not work, try reprocessing the files.

   • Records appearing in the Commit tabs will need to be re-processed.
• The **Insert** feature may be used if maintaining order is necessary.

2. **Review the ErrorMsg field** in the LAW PreDiscovery® case database to identify errors and determine what action will take place to resolve the error


- **Select the Failed Items tab**
  - Once the Failed Items tab has been selected then LAW PreDiscovery will search the "$Repository" in the case directory for native files that are copied to "$Repository\$Files", and the metadata information is copied to the "$Repository\$Metadata" folder.
  - If there are no records in either folder then you will get the prompt **"Failed item repository not found."**


- After selecting **OK**, **LAW Electronic Discovery Loader** will have **Failed Items** grayed out.
If there are records to be processed then LAW PreDiscovery will scan the $Repository for mailstores.

If no mail stores are present then following is displayed.

After selecting **OK**, **LAW Electronic Discovery Loader** displays $Files to be processed and the Source Path to the files in $Repository.
How to Reprocess Failed Items

To reprocess failed items, a new button named Failed Items has been added to LAW PreDiscovery Electronic Discovery Loader. Once the button is selected the "$Repository" folder is added to the Source queue.
Path to Reprocess Items is under Source Path

⚠️ Selecting **Failed Items** and then **Start** without first resolving the problem that caused the records to error during import will result in another copy of the errored file being imported into your database.

✅ Failed items are records from prior imports (since installing version 6.15.83) that failed for one of the following reasons: Write failed, Attachment Extraction failed, Embedded Image Extraction failed, and/or Compound Doc. Extraction failed.

Before reprocessing failed items through EDLoader, you will need to resolve the cause for the records to error.

✅ **Reprocessing password protected records**

Browse to the case folder/$Repository folder. The native files are copied to $Repository \$Files, and the metadata information is copied to the $Repository \$Metadata folder.

Open the $Files folder. All files will be listed with a unique identifier that corresponds to the metadata referenced in the $Metadata folder. Opening the file in the $Metadata folder in Notepad will provide the following metadata values: FolderPath, EntryID, SourceID, LawPath, EmailClient, ConversationIndex, ThreadID, ItemGUID, ReprocessedCount, ParentID, SourceFolderPath, SourceFileName, and FileName. The
following example has two Windows Explorer windows ($Files and $Metadata) and a $Metadata file open in Notepad.

In version 6.17.96+ you can add the password to ed loader before reprocessing the office files, 7zip, and pkzip files.

$Metadata folder and files are for reference only. Making changes to the $Metadata files will affect the ability to reprocess the records with errors.

The $Metadata file can be used to locate the FileName that matches the corresponding unique identifier in the $Files folder.

1. Open the record in $Files using the correct password.
2. Change the security settings disabling the need for a password.

3. Then save the record into the same $Files folder and with the original unique identifier as the filename.

Reprocessing records with other errors

For records that fail due to processing errors or metadata extraction errors, confirm that your Windows login has read/write permission to the case folder and all subfolders and files, %Temp%, and %appdata%. There isn't another program that is trying to access your source files during import.

If metadata extraction errors caused a record not to import then you may want to turn off metadata options during import and process post import by Extracting Custom Metadata.

After resolving errors that generated failed items during the original import

Select Failed Items in LAW Electronic Discovery Loader.

Change any import settings that need to be altered and select Start.

The Failed Items that have been resolved will now be imported into the database in the corresponding folder with the rest of the files from that source.

If the item is re-processed successfully, then the backed up file and its metadata info will be deleted from the "$Repository" folder.
If the item was an attachment, then the Parent document id will be added to the ErrorMsg field. This can be used to manually attach the item back to its parent.

Re-processed items will be in the corresponding source folder however these records are located at the end of that folder. These records can be moved and or attached to parent records as needed. Moving Documents and Pages Working with Attachments

Querying for reprocessed records in your database

A new document category has been added for reprocessed items. This allows users to search for all re-processed items in LAW. Select Tools then Search Records to pull up your Database Query Builder.

If you select the ellipses for _DocCat then Custom Value Selection [_DocCat] will open in a new window.
In the Search Results, the _DocCat field will populate with 131073 for successfully reprocessed documents and 131201 for reprocessed documents that still have errors.

<table>
<thead>
<tr>
<th>DocID</th>
<th>Filename</th>
<th>DocCat</th>
<th>ErrorMsg</th>
</tr>
</thead>
<tbody>
<tr>
<td>00002410</td>
<td>Thunderbolt</td>
<td>131073</td>
<td>Text Extraction E [Ext. est]. No valid text was extracted (3070)</td>
</tr>
<tr>
<td>00002415</td>
<td>Great Potato Casserle.pdf</td>
<td>131073</td>
<td></td>
</tr>
</tbody>
</table>

Re-processed items will be in the corresponding source folder however these records are located at the end of that folder. These records can be moved and or attached to parent records as needed. Moving Documents and Pages Working with Attachments
Populating the _GUID Field

The _GUID field was added to LAW PreDiscovery version 6.9.x. The _GUID field is automatically populated with the globally unique identifier (GUID) for each document being imported into LAW PreDiscovery using the ED Loader, LAW PreDiscovery case, or load file import. If a document doesn’t have an existing GUID in the _GUID field, LAW PreDiscovery will generate one and add it to the _GUID field.

During ED Loader imports, each file is automatically assigned a unique GUID.

During load file and LAW PreDiscovery case imports, if the load file or case contains the GUID field and it is populated for a file, the GUID field will be populated with the existing GUID value. If the GUID field does not exist or is not populated for a file, a unique GUID is automatically assigned to the file.

For documents imported into LAW PreDiscovery before version 6.9.x, or imported into LAW PreDiscovery using a different type of import, you can generate GUIDs for the documents using the Generate document GUIDs function on the Tools menu on the main form. When you run the Generate document GUIDs function, LAW PreDiscovery generates a GUID for any document in the case that does not have a GUID assigned to it in the _GUID field.

GUID values in the _GUID field cannot be modified.

For more information about the _GUID field, see Field Descriptions - LAW.

To manually generate GUIDs

1. From the main form on the Tools menu, click Generate document GUIDs.

   Clicking Generate document GUIDs starts the GUID generation process.

   Once the GUIDs are created for the documents in the case and the _GUID field is populated with the new GUIDs, the Document GUID Update Status dialog box opens. If the GUIDS were successfully created, the Document GUID Update Status dialog box indicates the number of documents updated and how long the process ran.
2. Click **OK** to close the dialog box.
Administering LAW PreDiscovery

LAW PreDiscovery supports many core administrative functions.

Configuring LAW and SQL

SQL Installation summary

Note the following about using SQL Server with LAW PreDiscovery:

- All testing has been performed internally using SQL Server 2008 - 2016 both full and Express versions.
- Please contact LexisNexis Technical Support for instructions on configuring your instance of SQL Server to run with LAW PreDiscovery. The following listing provides sample values to use to setup a configuration of SQL Server 2008 (Express) with Tools. Use this as a starting point when discussing a production oriented SQL Server configuration with LAW PreDiscovery technical support.

Please note that for SQLExpress versions 2008-2016 the maximum database size is 10GB per database. If you have need of a larger database then you will need to contact Microsoft about a full version license.

SQL 2016 and 2016 Express is supported in Version 6.17.96+

Installation Tasks

- Instance name: can use default -- for example, SQLEXPRESS
- Features: Database Engine Services and Management Tools - Basic
- Account Name: NT AUTHORITY \ NETWORK SERVICE
- Password = leave blank (default)
- Database Engine Configuration dialog box: Mixed Mode (SQL Server authentication and Windows authentication)
- SQL Administrator password: select a password of your choice.
- User accounts: Add Current User. Or add at least one Windows login or domain user account.

In SSMS (SQL Server Management Studio)

Create a new login:

- Login name: LAW_User
Authentication mode: **SQL Server authentication.**
Password: (Contact Technical support for assistance.)
Disable these password settings: Enforce password expiration, Enforce password policy, and User must change password at next login.
Select Server Roles: enable dbcreator

## Creating SQL Server user account(s)

There are two methods of specifying user accounts for use with SQL Server. You can use either of these methods to allow LAW PreDiscovery access to the LAW PreDiscovery cases stored on the server.

<table>
<thead>
<tr>
<th>Create a Global Default User for LAW PreDiscovery</th>
<th>Create Individual Users with Integrated Security</th>
</tr>
</thead>
</table>
| Use this method when using SQL Server for other applications in addition to LAW PreDiscovery®. This option helps to prevent users of SQL Server from accessing and modifying any other existing databases. **To create a generic global user account using this method:**
- Setup a SQL Server user with create/modify permissions.
- The user name and password must be:
  - **User:** LAW_User  
  - **Pwd:** (Contact Technical support for assistance.)

When using the default user, the security mode for SQL Server must be set to **SQL Server and Windows** or **mixed-mode** authentication.

This method allows a user to create SQL Server cases without adding a special user to SQL Server as long as the current user has database create permissions on the specified SQL Server. Windows integrated security may be used when accessing/creating SQL Server cases.

If using this method, each user must be setup on the SQL Server to allow access to the case.

**To enable this feature:**
- Select the **Use Windows NT integrated security** option when specifying the database backend for newly created cases.

### SQL 2008 Detailed setup example

This section describes an example of a known, working setup of SQL Server 2008 (Express) edition.

**Installation Steps**

**Step 1: Install SQL Server 2008 (Express) with Tools**

SQL Server 2008 (Express) with Tools includes the Microsoft SQL Server Management Studio console.
1. Download the installer file for **SQL Server 2008 (Express) with Tools** from the Microsoft website.

2. Run the installation file and then follow prompts to continue.

3. In **SQL Server Installation Setup** dialog box click **Installation**.

4. Click **New SQL Server stand-alone installation**.

5. After installation files expand click **OK**.

6. In the **Product Key** dialog box click **Next**.

7. In the **License Terms** dialog box, click **I accept**, if you accept the terms and then click **Next**.

8. In the setup support dialog boxes, follow prompts to continue.

9. In **Feature Selection**, select both of the following:
   - **Database Engine Services**
   - **Management Tools - Basic**

10. Click **Next**.

11. In **Instance Configuration**, using the default **SQLSERVER** is recommended although it is optional to change the instance name. Also, you can change the installation directory or leave the default.

12. Click **Next**.

13. In the **Disk Space Requirements** dialog box, click **Next**, assuming you have requisite disk space.

14. In the **Server Configuration** dialog box, next to **SQL Server Database Engine**:
   - In the **Account Name** field, select **NT AUTHORITY\NETWORK SERVICE**.
   - Leave the password blank.
   - Next to the **SQL Server Browser** field, under Startup Type, select **Automatic**.

15. Click **Next**.

16. In **Database Engine Configuration** dialog box, select **Mixed Mode (SQL Server authentication and Windows authentication)**.

17. In the **Enter password** and **Confirm password** fields, type the SQL administrator password you want to use. Recommended: write the password down in a secure location.

18. Under **Specify SQL Server administrators**, click **Add Current User**. Add other users as necessary, and then click **Next**.

19. In **Error and Usage Reporting**, select from options as needed and then click **Next**.

20. In **Installation Rules**, click **Next**.

21. In **Ready to Install** click **Install**. When **Setup Progress Complete** appears above the progress bar, click **Next**, and then click **Close**.
Step 2: Add SQL user account for LAW PreDiscovery

1. Start SQL Server Management Studio. This is located in the Start>All Programs>Microsoft SQL Server 2008> SQL Server 2008 Management Studio.

2. Login to the new SQL Server instance.

3. Expand Security, right click Logins, and then click New User.

4. In Login name type LAW_User.

5. Select SQL Server authentication.

6. In the Password and Confirm password fields type (Contact Technical support for password assistance.).

7. Deselect Enforce password expiration, Enforce password policy, and User must change password at next login.

8. In the left panel of the dialog box, click Select Server Roles and then select dbcreator.

9. Click OK.


Step 3: Add SQL instance Name to LAW PreDiscovery

1. On the File menu click New Case.

   Or

   On the main form toolbar click New Case.

2. The Select Database Engine dialog box appears.
If you are installing a full version of SQL, then you would only have the name of your SQL Instance in the screenshot above. It would not include \SQLExpress.

3. Select **SQL Server/ SQL Express**, and type the SQL instance name and select an authentication mode for the new case.
4. Click **OK**.
5. Continue case creation process Creating a New Case.

**SQL 2012 Detailed setup example**

This section describes an example of a known, working setup of SQL Server 2012 edition.

**Installation Steps**

1. Download the installer file for **SQL Server 2012 with Tools** from the Microsoft website.
2. Run the installation file and then follow prompts to continue.
3. In **SQL Server Installation Setup** dialog box click **Installation**.
4. Click **New SQL Server stand-alone installation**.
5. After installation files expand click **OK**.
6. In the **Product Key** dialog box click **Next**.

   If this is a full version of SQL then insert the SQL product key before selecting **Next**.

7. In the **License Terms** dialog box, click **I accept**, if you accept the terms and then click **Next**.

8. In the setup support dialog boxes, follow prompts to continue.

9. In **Feature Selection**, select both of the following:
   - **Database Engine Services**
   - **Management Tools - Basic**

10. Click **Next**.

11. In **Instance Configuration**, using the default **SQLEXPRESS** is recommended although it is optional to change the instance name. Also, you can change the installation directory or leave the default.

12. Click **Next**.

13. In the **Disk Space Requirements** dialog box, click **Next**, assuming you have requisite disk space.
14. In the **Server Configuration** dialog box, next to **SQL Server Database Engine**:
   - In the **Account Name** field, select **NT AUTHORITY\NETWORK SERVICE**.
   - Leave the password blank.

15. Click **Next**.

16. In **Database Engine Configuration** dialog box, select **Mixed Mode (SQL Server authentication and Windows authentication)**.

17. In the **Enter password** and **Confirm password** fields, type the SQL administrator password you want to use. Recommended: write the password down in a secure location.

18. Under **Specify SQL Server administrators**, click **Add Current User**. Add other users as necessary, and then click **Next**.

19. In **Error and Usage Reporting**, select from options as needed and then click **Next**.

20. In **Installation Rules**, click **Next**.

21. In **Ready to Install** click **Install**. When **Setup Progress Complete** appears above the progress bar, click **Next**, and then click **Close**.

22. Close the **SQL Server Installation Center**.
**Step 2: Add SQL user account for LAW PreDiscovery**

1. Start **SQL Server Management Studio**. This is located in the Start>All Programs>Microsoft SQL Server 2012> SQL Server 2012 Management Studio.

2. Login to the new SQL Server instance.

3. Expand **Security**, right click **Logins**, and then click **New User**.

4. In **Login name** type LAW_User.

5. Select **SQL Server authentication**.

6. In the **Password** and **Confirm password** fields type (Contact Technical support for password assistance.).

7. Deselect **Enforce password expiration**, **Enforce password policy**, and **User must change password at next login**.

8. In the left panel of the dialog box, click **Select Server Roles** and then select **dbcreator**.

9. Click **OK**.

10. Close **Microsoft SQL Management Studio**.

**Step 3: Add SQL instance Name to LAW PreDiscovery**

1. On the File menu click **New Case**.
   
   Or
   
   On the main form toolbar click **New Case**.

2. The Select Database Engine dialog box appears.
If you are installing a full version of SQL, then you would only have the name of your SQL Instance in the screenshot above. It would not include \SQLExpress.

3. Select SQL Server/ SQL Express, and type the SQL instance name and select an authentication mode for the new case.
4. Click OK.
5. Continue case creation process Creating a New Case.

SQL 2014 Detailed Setup Example

This section describes an example of a known, working setup of SQL Server 2014 edition.

Installation Steps

Step 1: Install SQL Server 2014 (Express) with Tools

SQL Server 2014 with Tools includes the Microsoft SQL Server Management Studio console.

1. Download the installer file for SQL Server 2014 with Tools from the Microsoft website.
2. Run the installation file and then follow prompts to continue.
3. In SQL Server Installation Setup dialog box click Installation.
4. Click New SQL Server stand-alone installation if this is a new instance.
If you are upgrading from a prior SQL installation then select **Upgrade from SQL Server 2005, SQL Server 2008, SQL Server 2008 R2 or SQL Server 2012.**

5. After installation files expand click **OK.**

6. In the **Product Key** dialog box click **Next.**

   - If this is a full version of SQL then insert the SQL product key before selecting **Next.**
7. In the **License Terms** dialog box, click **I accept**, if you accept the terms and then click **Next**.

8. In the setup support dialog boxes, follow prompts to continue.

9. In **Feature Selection**, select both of the following:
   - Database Engine Services
   - Management Tools - Basic

10. Click **Next**.

11. In **Instance Configuration**, using the default **SQLExpress** is recommended although it is optional to change the instance name. Also, you can change the installation directory or leave the default.

12. Click **Next**.

13. In the **Disk Space Requirements** dialog box, click **Next**, assuming you have requisite disk space.

14. In the **Server Configuration** dialog box, next to **SQL Server Database Engine**:
   - In the **Account Name** field, select **NT AUTHORITY\NETWORK SERVICE**
   - Leave the password blank.
Next to the SQL Server Browser field, under Startup Type, select Automatic.

15. Click Next.


17. In the Enter password and Confirm password fields, type the SQL administrator password you want to use. Recommended: write the password down in a secure location.

18. Under Specify SQL Server administrators, click Add Current User. Add other users as necessary, and then click Next.

19. In Error and Usage Reporting, select from options as needed and then click Next.

20. In Installation Rules, click Next.

21. In Ready to Install click Install. When Setup Progress Complete appears above the progress bar, click Next, and then click Close.

22. Close the SQL Server Installation Center.

Step 2: Add SQL user account for LAW PreDiscovery

1. Start SQL Server Management Studio. This is located in the Start>All Programs>Microsoft SQL Server 2014>SQL Server 2014 Management Studio.
2. Login to the new SQL Server instance.
3. Expand **Security**, right click **Logins**, and then click **New User**.
4. In **Login name** type LAW_User.
5. Select **SQL Server authentication**.
6. In the **Password** and **Confirm password** fields type (Contact Technical support for password assistance.).
7. Deselect **Enforce password expiration**, **Enforce password policy**, and **User must change password at next login**.
8. In the left panel of the dialog box, click **Select Server Roles** and then select **dbcreator**.
9. Click **OK**.
10. Close **Microsoft SQL Management Studio**.

**Step 3: Add SQL instance Name to LAW PreDiscovery**

1. On the File menu click **New Case**.
   Or
   On the main form toolbar click **New Case**.
2. The Select Database Engine dialog box appears.
If you are installing a full version of SQL, then you would only have the name of your SQL Instance in the screenshot above. It would not include SQLExpress.

3. Select **SQL Server/ SQL Express**, and type the SQL instance name and select an authentication mode for the new case.
4. Click **OK**.
5. Continue case creation process Creating a New Case.

---

**SQL 2016 Detailed Setup (LAW Version 6.17.96+)**

This section describes an example of a known, working setup of SQL Server 2016 edition.

**Installation Steps**

**Step 1: Install SQL Server 2016 (Full)**

SQL Server 2016 Full includes the Microsoft SQL Server Management Studio console.

1. Download the installer file for SQL Server 2016 from the Microsoft website.
2. Run the installation file and then follow prompts to continue
3. In **SQL Server Installation Setup** dialog box click **Installation**.
4. Click **New SQL Server Standalone installation** if this is a new instance.

5. SQL Server 2016 Full includes the Microsoft SQL Server Management Studio console.
If you are upgrading from a prior SQL installation then select *Upgrade from a previous version of SQL Server.*

6. After installation files expand click **OK**.

7. In the **Product Key** dialog box, insert the SQL Product Key before selecting **Next**.

8. In the **License Terms** dialog box, click **I accept**, if you accept the terms and then click **Next**.

9. In the setup support dialog boxes, follow prompts to continue.

10. In **Feature Selection**, select both of the following:

11. **Database Engine Services**

12. **Management Tools - Basic**

13. Click **Next**.

14. In **Instance Configuration**, using the default **MSSQLSERVER** is recommended although it is optional to change the instance name. Also, you can change the installation directory or leave the default.

15. Click **Next**.

16. In the **Disk Space Requirements** dialog box, click **Next**, assuming you have requisite disk space.
17. In the **Server Configuration** dialog box, next to **SQL Server Database Engine**:
18. In the Account Name field, select **NT AUTHORITY\NETWORK SERVICE**
19. Leave the password blank.

![Server Configuration dialog box](image)

20. Next to the SQL Server Browser field, under Startup Type, select Automatic.
21. Click **Next**.

22. In **Database Engine Configuration** dialog box, select **Mixed Mode (SQL Server authentication and Windows authentication)**.

23. In the Enter password and Confirm password fields, type the SQL administrator password you want to use. Recommended: write the password down in a secure location.

24. Under **Specify SQL Server administrators**, click **Add Current User**. Add other users as necessary, and then click **Next**.

25. In **Error and Usage Reporting**, select from options as needed and then click **Next**.
26. In **Installation Rules**, click **Next**.

27. In **Ready to Install** click **Install**. When **Setup Progress Complete** appears above the progress bar, click **Next**, and then click **Close**.

28. Close the **SQL Server Installation Center**.

2. **Step 2: Add SQL user account for LAW PreDiscovery**

1. Start **SQL Server Management Studio**. This is located in the Start>All Programs>Microsoft SQL Server 2012> **SQL Server 2012 Management Studio**.

2. Login to the new SQL Server instance.

3. Expand **Security**, right click **Logins**, and then click **New User**.

4. In **Login name** type **LAW_User**.

5. Select **SQL Server authentication**.

6. In the **Password** and **Confirm password** fields type (Contact Technical support for password assistance.).

7. Deselect **Enforce password expiration**, **Enforce password policy**, and **User must change password at next login**.

8. In the left panel of the dialog box, click **Select Server Roles** and then select **dbcreatore**.

9. Click **OK**.


3. **Step 3: Add SQL instance Name to LAW PreDiscovery**

1. On the File menu click **New Case**.

2. Or

3. On the main form toolbar click **New Case**.

4. The Select Database Engine dialog box appears.
If you are installing a full version of SQL, then you would only have the name of your SQL Instance in the screenshot above. It would not include SQLExpress.

5. Select SQL Server/SQL Express, and type the SQL instance name and select an authentication mode for the new case.

6. Click OK.

7. Continue case creation process Creating a New Case.

SQL Considerations and recommendations for use with LAW

The Answer Center provides the minimum and recommended versions of SQL for use with your specific version of LAW PreDiscovery® it is recommended to consult the system requirements before installing SQL.

- The following are considerations and recommendations for a SQL database administrator when setting up an instance of SQL for use with LAW PreDiscovery and/or Early Data Analyzer.

Suggestions setting up SQL for use with LAW PreDiscovery

- Document your installs so that server instances can easily be reproduced.
  1. Computer/server name where SQL is installed
  2. SQL administrator password
  3. SQL Instance name

If you write your password down it recommended to keep it in a secure location,
possibly off-site.

- Install only the SQL Server Services that you are going to need. LAW only needs the **SQL Server Database Engine** and **SQL Server Browser** services.

![Server Configuration](image)

**Services not needed for use with LAW.**

You can install the SQL Server Agent if you intend to run jobs on the server or do maintenance tasks such as automated backups. However, this function is best handled by a DBA. The other services (SQL Server Analysis and SQL Server Reporting Services) are unnecessary for LAW/Early Data Analyzer and consume valuable resources on your server.

- It is best to locate your databases (.mdf and .ldf) and your tempdb on separate physical disks; preferably NOT a USB-connected disk. This makes it easier to troubleshoot disk access problems, should they occur.
- We do not recommend the use of NTFS data file encryption or compression on SQL server databases and log files.

**Suggestions for configuring your instance of SQL for use with LAW PreDiscovery**
SQL Server max memory allocation is uncapped by default. This should be capped at approximately 80% of the physical memory allocated to the machine. For example, a server with 32 GB of physical RAM should be capped in SQL Server Management Studio at 25600 MB.

**Configuring your SQL Server max memory allocation.**

1. Open the SQL Instance through the SQL Server Management Studio.
2. Then right click on the Instance name and select Properties.
3. Then select the Memory tab.
4. The **Maximum server memory (in MB)**: should be approximately 80% of your servers available memory unless you have multiple instances on the same server.

- Leave the “auto create statistics” and “auto update statistics” options on for all user databases. Only in very rare cases should these be turned off, and if they are turned off, then you must manually update the statistics yourself. Please see Microsoft’s website for more information.

- Do not use the “auto shrink” database option, as it can waste SQL Server resources unnecessarily and contribute to index fragmentation. Instead, if you need to shrink a database, do so manually. For more information please see Microsoft’s website on Considerations for the "autogrow" and "autoshrink" settings.

- Do not rely on AUTOGROWTH to automatically manage the size of your databases. Instead, proactively monitor and alter database size as circumstances dictate. Only use AUTOGROWTH to deal with unexpected growth. For more information please see Microsoft's website on Considerations for the "autogrow" and "autoshrink" settings.

**Suggestions for SQL maintenance**

- Set up daily full backups of your databases. You can set a job to schedule your backups as long as you have SQL Agent service running.

- Perform full backups during periods of low user activity in order to minimize the impact of backups on users.

- Periodically perform "test backup restores" to ensure that your backups are good and can be restored.

- Store backups offsite and in a secure location.
Reference Information
Reference Information

This section contains reference items.

Glossary

A – B – C

Acrobat

An application by Adobe Corporation for creating, reading, and editing PDF files.

archive file

A file type whose purpose is to store compressed copies of other files. The ZIP file is a common type of archive file. Other types of archive files are:

- RAR
- JAR
- GZIP
- Z
- TAR

ED Loader can import archive files and the files they contain either as multiple separate files or as a single-file archive. The files within the archive are called attachments.

attachments

Attachments are files that are linked to or embedded within other files. For example, word processor files are commonly found attached to e-mail messages.

An attachment relationship is displayed by indenting attachments below its parent document or archive.

Batch Process

The tool you use to perform page and document numbering, image cleanup, endorsing images, OCR, printing, e-printing, scanning for suspected footers, TIFF/PDF conversion, and updating page data. Batch processing can be done using just a single computer, or by distributing the job among 2 or more networked computers by using the LAW Management
Console.

**Batch Update**

The tool you use from a grid display to update all currently visible records in a grid. For example, you could use the Batch Update tool to reassign all selected records to a different custodian. Before you can use the Batch Update tool, the field that you want to update must be unlocked for editing. See also Modify Fields.

Tools -> Batch Update

**Bates numbering**

A system for uniquely identifying individual documents or pages using a sequential alphanumeric code.

**case**

1. In LAW PreDiscovery, the basic unit of organization for a set of source documents and source metadata; and the metadata and operational settings associated with that set of documents. 2. In Early Data Analyzer, the basic unit of organization for identifying sets of source documents, applying filters, exporting, and other functions related to prefiltering.

Cases in Early Data Analyzer and LAW PreDiscovery are managed and stored in separate databases.

**case name**

Case name is the only property required when you create a database. LAW PreDiscovery provides you with a default name of New Case, but we advise you use a more descriptive name. LAW PreDiscovery uses the case name as the root directory of the case.

**compound document**

A document created in one application that contains information created in another application. For example, a Word document can contain a worksheet developed in Excel. When you import compound documents you can specify whether a compound document will be extracted or not.

**custodian**

The party responsible for safe keeping of documents. In ED Loader, prior to importing, you can identify the custodian responsible for source documents. You can also access the Custodian Manager from ED Loader to manage the list of custodians available for a case. After import, the Custodian field is locked by default.

You can update the custodian after import. To do so, unlock the field for editing (Index -> Modify Fields), and then you can reassign the custodian manually by using the folder view or Index tab. Or you can use the Batch Update utility accessible from a grid view.

**D – E – F**

**data source**

In LAW PreDiscovery, a data source is the collection of MS Word docs, Excel worksheets, Adobe .pdf files, winzip .zip files, or others, to be imported into a case.

**database**
A type of data structure in which information is organized in one or more tables. LAW PreDiscovery cases are managed each in its own database. See also table.

database engine
The software application used to organize, manage and query information stored in a database.

Deduplication Utility
The tool used for determining if there are multiple copies of the same document in a case.

default value
A value that LAW PreDiscovery uses to populate a field. For example, the default value for the name of a new case is ‘New Case.’ The default value for Case is Active is ‘Yes.”

delimited text
A method of representing a table of information in a text file. In delimited text, the table columns are separated by a designated character, such as a comma or tab character.

Example:
Order number,CustomerName
1,Smith
2,Jones
3,Brown

Typically a comma is used to separate values. A comma-separated value (CSV) file contains comma delimited text. One of the six kinds of source files you can import into a LAW PreDiscovery case.

DocExt
DocExt is the name for one of the fields in the case database. It's an abbreviation for 'document extension.' See Document and Document Extension.

DocID
A unique value that LAW PreDiscovery assigns to each document in a case.

DocID seed
A unique eight-digit number that you can specify as the starting point for document numbering before importing source docs into the case.

document
Used interchangeably with ‘file.’ a document is composed of one or more pages, has a three-character extension, and a unique ID created during import.

document extension
The suffix added to a filename that identifies the format of its contents. For example, the document extension of text files is TXT. During electronic discovery, LAW PreDiscovery analyzes file contents and records the file extensions in the DocExt field. If a file’s contents
do not match the extension, the SuspectExt field is checked. For documents with suspected extensions the OrigExt field is populated with the extension associated with the type of file, as inferred by LAW PreDiscovery.

document numbering

One of the batch processes applied to the results of an import session. You can opt for numbering each page of every document, placing the number that LAW PreDiscovery generates in the PageID field, and specifying the serial number to start counting from.

document review software

A type of litigation support software that consumes the export product of LAW PreDiscovery.

e-doc


Early Data Analyzer

An optional software component of LAW PreDiscovery that performs high-speed prefiltering of large document sources.

electronic discovery

The process of finding information in electronic documents that is important to litigation. In LAW PreDiscovery you use ED Loader to import electronic files. These files then constitute the source documents for further discovery processing.

e-mail store

A type of file that contains individual email messages.

endorsing

Imprinting an image or PDF file, such as a logo on TIFFs. One of the batch processes applied to the results of an import session. You can opt for endorsing every image or PDF file or only the first page of every image or PDF file.

e-print

One of the batch processes that you can run on electronic documents. Prints the native document using application software external from LAW PreDiscovery.

ErrorMsg

One of the built-in fields that LAW PreDiscovery adds to the project database, error messages tell you that LAW PreDiscovery was either unable to extract data from a document, or write that data to the database.

exclusions

Rules that prevent certain items from being processed.

export

The process of packaging documents and metadata in formats suitable for use by software applications outside of LAW PreDiscovery.
Export Utility

Used for specifying what data will be exported to document review software. In the Export utility you specify: the documents to be exported, the data fields and values of interest, the export format, file name and path, and the naming scheme for exported files and folders.

field

One of the properties associated with a document or page. Examples include: document identification number (DocId), page identification number (PageID), document file extension (DocExt), etc. You use fields as a basis for filtering and analyzing documents. By default, LAW PreDiscovery creates and populates many fields for documents and pages that it processes. You can lock or unlock fields, or create new fields for your own purposes by using the Modify Fields dialog box.

field list

A tool in the grid display you use to control which fields are visible in the grid. Checked items are visible, unchecked are not. All the properties associated with a document. For example the three fields in the screen shot tell you the date when a file was created, the date for the last time it was modified, and the date when it was last printed. All of these fields are populated by the operating system.

file description

Information about a document stored in the FileDescription field.

Folder

A container for documents and pages.

From:

Found in email, saved in the To field of the database so that you can search for all of the emails that were sent by an individual.

G – H – I

grid

A type of display in LAW PreDiscovery that enables you to view lists of document and page records each in a single row in a table. You can configure grids to show whichever metadata fields you are interested in. You can also define custom sorting and reuse saved views.

The embedded grid is built into the main window of LAW PreDiscovery and is designed to provide a snapshot view, showing just a few records and fields at a time. There is also a standalone grid that runs in its own window and can be more useful for reviewing larger record sets and more fields.

hash value

A value assigned to a particular document that uniquely identifies it. Hash values for files are generated by the Deduplication utility to identify files suspected of being duplicates. There is a slight margin of error when creating file hashes and this factor decreases with the strength of the working digest used to create the hash. For most projects, configuring the Deduplication utility to use 128-bit strength is sufficient to positively identify duplicates. You can use a stronger digest for extremely high reliability but at a cost of processing efficiency.
**header/footer**

Batch process for adding headers and footers to the image of a page before exporting.

**image**

One of the three options for viewing a document in LAW PreDiscovery. For example, the image tab contains a picture of the document. The image is like a Xerox copy of a document. You can read it, but you can’t be change it.

**image cleanup**

A batch process for deskewing images, removing black borders found in the original images, or and random black marks that are not part of the image.

**index field**

A term that describes a field whose purpose is to hold sequential numbering of documents or pages.

**IrfanView**

A graphic viewer application by Irfan Skiljan for imaging many supported file formats.

**J – K – L**

**LAW case**

One of the six kinds of source files you can import into a LAW PreDiscovery case. LAW PreDiscovery Case allow users to import an existing LAW PreDiscovery case (created in version 4.x or 5.x) into a new or existing LAW PreDiscovery case.

**load file**

One of the six kinds of source files you can import into a LAW PreDiscovery case. Load files are produced by litigation support applications for the purpose of packaging source files and other information for import and export to other programs.

**Log Viewer**

A utility that provides access to LAW PreDiscovery logs.

**M – N – O**

**mail store**

A type of file that acts as a container for individual e-mail messages. Outlook mail stores have the PST extension.

**metadata**

The information about a file, document or page other than its content. Examples of metadata include: author, date created, file size, file type, page dimensions, and many others. Much metadata is collected in the process of electronic discovery during the import process. Metadata is useful as a basis for creating queries.

**Modify Fields**
The tool you use to add, delete, lock, or unlock the fields associated with a case. See also Batch Update.

naming scheme

A set of rules you define that govern naming of various objects in LAW PreDiscovery, such as projects, cases, and folders. Creating a naming scheme helps to maintain organization over sources and cases.

noise (visual)

Blemishes, dust, creases and other imperfections in images that can reduce the accuracy and speed of OCR. If scanned images are known to contain fair amounts of noise, you can run a batch process to remove noise, before you run a batch process to OCR the images.

noise (words)

Words that are ignored by processes of text indexing and full text search. Examples of noise words include: are, the, and, but, in, etc.

Open File

An option for viewing files. Opens the native document using the source application of the document.

optical character recognition (OCR)

The capability of extracting text from images. LAW PreDiscovery can perform OCR on scanned pages of documents or pictures.

P – Q – R – S

path

A description of the location in the file system of a volume, file, or folder. For example, C:\Program Files\test.txt represents the path to a test file located in the Program Files folder on the C: drive.

prefiltering

An optional action that can be performed on document sets prior to their import into a LAW PreDiscovery case. This function is accomplished by the use of LexisNexis® Early Data Analyzer.

Print Options

A batch process for preparing documents for output to a printer.

properties

The fields of a document.

For example one of the properties of a computer file is its name. Other properties would include the name of its author, the date it was created, the application that was used to create it.

quality control (QC)

The process of ensuring that the results of one phase of discovery are complete, accurate,
and usable by subsequent phases. After import, for example, QC may consist of reviewing and resolving errors and warnings. Prior to OCR, QC may consist of applying image cleanup batch processes to TIFFs.

**Query Builder**

A tool for finding documents and pages that match conditions you select based on field data and/or full text conditions. Query Builder can send results to be sent to a grid for further analysis or to a batch process, update utility, or direct to export.

**range file**

A range file is a delimited text file with two fields, BegDoc# and EndDoc#. You can use a range file when you want to reorganize documents, validate document ranges or to import images from a Doculex imagebase.

**raw images**

One of the six kinds of source files you can import into a LAW PreDiscovery case, raw images are read-only image files without an accompanying database or a load file.

**record**

A single row in a database. In a LAW PreDiscovery case, a record is represented in a grid as the values held in a row of fields. A record holds all the properties and values associated with a particular document or page.

**recursive**

Directing processing to take place on all items in a folder and then all its subfolders. Recursive processing helps to ensure all items in a deep folder structure are processed.

**root directory**

The top level folder in a directory structure.

**session**

A job run in ED Loader.

**Session Browser**

The utility in ED Loader for reviewing the details of previously run jobs.

**session label**

A unique name that LAW PreDiscovery creates every time it's importing files into the case.

For example, the default value for a session label is Session Created on [&Created]. When LAW PreDiscovery starts a session, it reads the date and time from the computer and adds that information to the phrase above.

**Session Viewer**

A feature of the ED Loader that provides access to logs of previous import sessions.

**source**

A file or folder identified for processing by the Early Data Analyzer.
source name

The folder or file name associated with an item bound for import in ED Loader.

Source Queue

In ED Loader, a control that shows a list of items bound for processing. When you use ED Loader, you must specify items to import based on source type, for example, Outlook folder, files, file lists, etc. You can identify multiple items to import before you press the Start button. When you select an item for processing it is added to the Source Queue list.

SourceApp

A field that names the application that originally produced a document.

sources

The files that ED Loader imports into a case.

T – U – V

tag list

A text (.txt) or comma separated value (.csv) file containing a list of unique identifiers used to locate the records in the case. The unique identifiers typically used in tag lists are the DocID or BegDoc# field. You use tag lists to help speed up the process of defining special fields for a case. A tag list allows you to save and reuse special fields between cases. See Importing Tag Lists.

Text tab

One of the three options for viewing a document in LAW PreDiscovery, the Text tab displays any text extracted from a document.

TIFF

One of several popular image file formats and the most commonly used image format used in the legal profession for rendering documents.

TIFF/PDF conversion

The process of rendering scanned documents and other electronically stored information (ESI) into the TIFF image or PDF file format. The Batch Processing utility can then be used to apply Bates numbering, OCR, and other actions to the files.

Title

A metadata field found in office documents. The document title and other metadata is extracted by ED Loader during the import phase of electronic discovery. After import, you can use Query Builder to query documents by words found in the Title field.

To:

A metadata field for e-mail records that is extracted during the import phase of electronic discovery. After import, you can use Query Builder easily find all the e-mails in a document collection that were sent to a particular individual by creating a query on the To: field.

unique value
A value in a field that is unique to that field for all records in a database. For example, in an employee database, no two records should have the same Social Security number.

value

The information stored in a particular database field for a specific record. For example, the Author field for a document might contain the value “Smith”.

W – X – Y - Z

Languages

LAW PreDiscovery can recognize the languages that exist in imported documents. For more information see: Text Extraction. The languages recognized are listed in the following table:

<table>
<thead>
<tr>
<th>Supported Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>LANG_AFRIKAANS</td>
</tr>
<tr>
<td>LANG_ALBANIAN</td>
</tr>
<tr>
<td>LANG_ALSATIAN</td>
</tr>
<tr>
<td>LANG_AMHARIC</td>
</tr>
<tr>
<td>LANG_ARABIC</td>
</tr>
<tr>
<td>LANG_ARMEINIAN</td>
</tr>
<tr>
<td>LANG_ASSAMESE</td>
</tr>
<tr>
<td>LANG_AZERI</td>
</tr>
<tr>
<td>LANG_AZERI_CYRILLIC</td>
</tr>
<tr>
<td>LANG_AZERI_LATIN</td>
</tr>
<tr>
<td>LANG_BASHKIR</td>
</tr>
<tr>
<td>LANG_BASQUE</td>
</tr>
<tr>
<td>LANG_BELARUSIAN</td>
</tr>
<tr>
<td>LANG_BENGALI</td>
</tr>
<tr>
<td>LANG_BRETON</td>
</tr>
<tr>
<td>LANG_BULGARIAN</td>
</tr>
<tr>
<td>LANG_BURMESE</td>
</tr>
<tr>
<td>LANG_CAMBODIAN</td>
</tr>
</tbody>
</table>
Supported Languages

<table>
<thead>
<tr>
<th>LANG_CATALAN</th>
<th>LANG_INDONESIAN</th>
<th>LANG_PAPIAMENTU</th>
<th>LANG_TURKISH</th>
</tr>
</thead>
<tbody>
<tr>
<td>LANG_CHEROKEE</td>
<td>LANG_INUKTITUT</td>
<td>LANG_PASHTO</td>
<td>LANG_TURKMEN</td>
</tr>
<tr>
<td>LANG_CHINESE</td>
<td>LANG_IRISH</td>
<td>LANG_POLISH</td>
<td>LANG_UIGHUR</td>
</tr>
<tr>
<td>LANG_CHINESE_SIMPLIFIED</td>
<td>LANG_ITALIAN</td>
<td>LANG_PORTUGUESE</td>
<td>LANG_UKRAINIAN</td>
</tr>
<tr>
<td>LANG_CHINESE_TRADITIONAL</td>
<td>LANG_JAPANESE</td>
<td>LANG_PUNJABI</td>
<td>LANG_URDU</td>
</tr>
<tr>
<td>LANG_CORSICAN</td>
<td>LANG_KANADA</td>
<td>LANG_QUECHUA</td>
<td>LANG_UZBEK</td>
</tr>
<tr>
<td>LANG_CROATIAN</td>
<td>LANG_KANURI</td>
<td>LANG_ROMANSH</td>
<td>LANG_UZBEK_CYRILLIC</td>
</tr>
<tr>
<td>LANG_CZECH</td>
<td>LANG_KASHMIRI</td>
<td>LANG_ROMANIAN</td>
<td>LANG_UZBEK_LATIN</td>
</tr>
<tr>
<td>LANG_DANISH</td>
<td>LANG_KAZAK</td>
<td>LANG_RUSSIAN</td>
<td>LANG_VENDA</td>
</tr>
<tr>
<td>LANG_DARI</td>
<td>LANG_KICHE</td>
<td>LANG_SAMI</td>
<td>LANG_VIETNAMESE</td>
</tr>
<tr>
<td>LANG_DIVEHI</td>
<td>LANG_KINYARWANDA</td>
<td>LANG_SANSKRIT</td>
<td>LANG_WELSH</td>
</tr>
<tr>
<td>LANG_DUTCH</td>
<td>LANG_KONKANI</td>
<td>LANG_SERBIAN</td>
<td>LANG_WOLOF</td>
</tr>
<tr>
<td>LANG_EDO</td>
<td>LANG_KOREAN</td>
<td>LANG_SERBIAN_CYRILLIC</td>
<td>LANG_XHOSA</td>
</tr>
<tr>
<td>LANG_ENGLISH</td>
<td>LANG_KYRGYZ</td>
<td>LANG_SERBIAN_LATIN</td>
<td>LANG_YAKUT</td>
</tr>
<tr>
<td>LANG_ESTONIAN</td>
<td>LANG_LAOTHIAN</td>
<td>LANG_SINDHI</td>
<td>LANG_YI</td>
</tr>
<tr>
<td>LANG_FAEROESE</td>
<td>LANG_LATIN</td>
<td>LANG_SINHALESE</td>
<td>LANG_YIDDISH</td>
</tr>
<tr>
<td>LANG_Farsi</td>
<td>LANG_LATVIAN</td>
<td>LANG_SLOVAK</td>
<td>LANG_YORUBA</td>
</tr>
<tr>
<td>LANG_FINNISH</td>
<td>LANG_UITHUANIAN</td>
<td>LANG_SLOVENIAN</td>
<td>LANG_ZULU</td>
</tr>
</tbody>
</table>

License Matrix

Each type of LAW PreDiscovery license is shown with its corresponding LAW PreDiscovery interface items.

For more information about each of the licenses and the Early Data Analyzer and TSI Scan licenses, see License Types and Early Data Analyzer documentation as appropriate.
<table>
<thead>
<tr>
<th>FILE</th>
<th>OPEN CASE</th>
<th>NEW CASE</th>
<th>SAVE</th>
<th>SAVE AS</th>
<th>IMPORT</th>
<th>DELIMITED TEXT</th>
<th>LAW CASE</th>
<th>LOAD FILE</th>
<th>TAG LIST</th>
<th>RAW IMAGES</th>
<th>ELECTRONIC DISCOVERY</th>
<th>PRINT</th>
<th>PRINT SETUP</th>
<th>SEND</th>
<th>IMAGE</th>
<th>IMAGE + OCR</th>
<th>OCR ONLY</th>
<th>ADMINISTRATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>NEW CASE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAVE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAVE AS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMPORT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DELIMITED TEXT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAW CASE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOAD FILE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TAG LIST</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RAW IMAGES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ELECTRONIC DISCOVERY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRINT</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>PRINT SETUP</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SEND</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>IMAGE</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>IMAGE + OCR</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>OCR ONLY</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>ADMINISTRATION</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>APPLY CASE TEMPLATE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CASE SUMMARY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMPACT DATABASE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>REORGANIZE DOCUMENTS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAVE CASE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEMPLATE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCAN FOR ERRORS</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VALIDATE RANGES</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCAN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SELECT SCANNER</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCANNER SETTINGS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCAN OPTIONS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NEW DOCUMENT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NEW ATTACHMENT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>APPEND</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDIT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INSERT</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NEW PAGE(S)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXISTING PAGE(S)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E-DOCUMENT(S)</td>
<td>*requires both Edit and ED Loader</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCANNED DOCUMENT</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DELETE</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>REPLACE</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUTO NUMBER</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ATTACHMENTS</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MERGE DOCUMENTS</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MOVE DOCUMENTS</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RESET OCR FLAGS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RESET FULL TEXT FLAGS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPLIT DOCUMENTS</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIEW PAGE INFO *requires both Edit and Admin</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PROPERTIES</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FOLDER</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NEW</td>
<td></td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPEN</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUTO-CREATE</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUTO-CREATE FOLDERS</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COLLAPSE</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXPAND</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DELETE</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXTRACT AS SUBSET</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRID VIEW</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRID VIEW (RECURSE)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUMMARIZE IMAGES</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RENAME</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MOVE</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PROPERTIES</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INDEX</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2018 LexisNexis. All rights reserved.
<table>
<thead>
<tr>
<th>Feature</th>
<th>X</th>
<th>X</th>
<th>X</th>
<th>X</th>
<th>X</th>
<th>X</th>
</tr>
</thead>
<tbody>
<tr>
<td>BATES NUMBERING</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>IMAGE CLEANUP</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>ENDORSE IMAGE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>PRINT (IMAGES)</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>E-PRINT (NATIVES)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>SCAN FOR SUSPECT FOOTERS</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>LOG VIEWER</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>OCR</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TIFF/PDF CONVERSION</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>UPDATE PAGE DATA</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>DISTRIBUTED BATCH PROCESSING</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>EXPORT UTILITY</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEDUPLICATION UTILITY</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DUPLICATE VIEWER</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>NEAR-DUPLICATE &amp; EMAIL THREAD ANALYSIS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>ANNOTATIONS</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BARCODES</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAUNCH VIEWER</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OCR</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FULL TEXT INDEX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>RUN COMMAND</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>DISPLAY ALL RECORDS</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>SEARCH RECORDS</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>OPTIONS</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>HELP</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HELP TOPICS</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>USER GUIDE</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>BUG REPORT</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>CHECK FOR UPDATE</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>ABOUT LAW</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>OPEN FILE</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AUTOVUE SUITE</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HEX EDITOR</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>INTERNET EXPLORER</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MICROSOFT WORD</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>NOTEPAD</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>QUICK VIEW PLUS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CHOOSE PROGRAM</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CHANGE SOURCE APPLICATION</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AUTOVUE SUITE REVIEW MODE</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>QUICK VIEW PLUS REVIEW MODE</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>REVIEW PARENT E-MAILS NATIVELY</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>LOTUS NOTES REVIEW MODE</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Unicode Support

The general requirements and supported functionality for Unicode are listed as follows:

- LAW PreDiscovery® versions 5.2 and higher support the Unicode® Standard.
- Proper language packs must be installed for the associated Unicode characters to render correctly.
- To print Unicode text files, use either Microsoft Word or the Shell Printer as the source application. The Text/RTF Printer can print RTF with Unicode, however it cannot print Unicode text files.
- If using the Shell Printer, you must ensure that the application registered on the system for text files supports shell prints. For example, Notepad supports shell prints.
- The ExperVision and TextBridge OCR engines do not currently support Unicode.
- Supported languages for OCR can be found in the Language drop-down list located in the OCR tab in Tools -> Options.
- Printed and extracted text will contain Unicode data if it exists in the original file and can be displayed, provided the proper language pack(s) are installed on the system.

To view Unicode in a grid

- In a grid view, rest the mouse pointer over a cell that contains Unicode characters.
  The text appears in a pop-up text box.

Unicode in names for files, cases, and fields

- Files with Unicode file names or residing in a Unicode path may be imported using the ED Loader. These Unicode paths can be retained and displayed in the main folder view and any other applicable folder view in the application. Unicode existing in the metadata will be retained and can be displayed in the Index display.
- Unicode is not supported in case names. While the rest of the case path can contain Unicode, it is recommended the case paths do not contain Unicode characters to avoid potential issues with 3rd party applications.
- Index field names cannot contain Unicode characters.

Exporting Unicode data

Unicode data can be sent to the export file when exporting field data from a grid.

- In the Save Results As dialog box, in the Save as type list, select Unicode Text (Tab delimited)(*.csv).
Exporting Unicode

Export Formats

Unicode data is supported in the Export Utility in the following export formats:

- **CaseLogistix** - Unicode is automatically included if present in the exported data.
- **Delimited Text** - Unicode data will be included only if the **Allow Unicode data (UCS-2 format)** option is enabled in this format's configuration settings.
- **EDRM XML 1.0** - Unicode is automatically included if present in the exported data.
- **EDRM XML 2.0** - Unicode is automatically included if present in the exported data.
- **Concordance Direct DCB** - Unicode data will be included only if LexisNexis Concordance 10 or above is installed on the computer and **Create Concordance 10.0 database (supports Unicode)** is enabled in the configuration settings for that format.
- **Concordance** - Unicode data will be included only if the **Allow Unicode data (UCS-2 format)** is enabled in this format's configuration settings.

Export Utility Restrictions

When using the Export Utility, if you export to a format that does not support Unicode characters:

- Do not use the **Mirror Original** folder naming scheme if Unicode folders exist in the case.
- Ensure the export path does not contain Unicode characters. Unicode paths and filenames may prevent the target applications from opening associated images, text, or native files.

Keyboard Shortcuts

If the keyboard shortcuts are not functioning, and a grid display is currently active, please ensure that Review Mode is disabled in the grid. See Tagging Records for more information.

For a downloadable copy of the keyboard shortcuts see [LAW PreDiscovery Keyboard Reference](#).

Function keys
## Control keys

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT+UP ARROW</td>
<td>Increase scan brightness (32pts)</td>
</tr>
<tr>
<td>ALT+DOWN ARROW</td>
<td>Decrease scan brightness (32pts)</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>Select All Pages (if thumbnails display has focus)</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>Select All Documents (if document list has focus)</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>Show All Fields (if Search Results window has focus)</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>Hide All Fields (if Search Results window has focus)</td>
</tr>
<tr>
<td>CTRL+E</td>
<td>Edit Page ID</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Find Page ID</td>
</tr>
<tr>
<td>CTRL+G</td>
<td>Go To Page</td>
</tr>
<tr>
<td>CTRL+L</td>
<td>Rotate Left (current or selected pages)</td>
</tr>
<tr>
<td>CTRL+M</td>
<td>Merge Documents</td>
</tr>
<tr>
<td>CTRL+O</td>
<td>OCR Document</td>
</tr>
<tr>
<td>CTRL+P</td>
<td>Print</td>
</tr>
<tr>
<td>CTRL+R</td>
<td>Rotate Right (current or selected pages)</td>
</tr>
</tbody>
</table>

** Availability of these modes depends on whether the scanner support for these capabilities.
<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+S</td>
<td>Save Image (saves image with current page orientation)</td>
</tr>
<tr>
<td>CTRL+U</td>
<td>Split Document</td>
</tr>
<tr>
<td>CTRL+Z</td>
<td>Zoom Lock</td>
</tr>
<tr>
<td>CTRL+1</td>
<td>Black and White Scanning</td>
</tr>
<tr>
<td>CTRL+2</td>
<td>8-bit Grayscale Scanning</td>
</tr>
<tr>
<td>CTRL+3</td>
<td>24-bit Color Scanning</td>
</tr>
<tr>
<td>CTRL+F3</td>
<td>Scan New Attachment</td>
</tr>
<tr>
<td>CTRL+F4</td>
<td>Enhance Image menu</td>
</tr>
<tr>
<td>CTRL+F6</td>
<td>Replace Document</td>
</tr>
<tr>
<td>CTRL+F12</td>
<td>Merge Annotations</td>
</tr>
<tr>
<td>CTRL+INSERT</td>
<td>Insert New Pages (from scanner)</td>
</tr>
<tr>
<td>CTRL+PAGE DOWN</td>
<td>Zoom In</td>
</tr>
<tr>
<td>CTRL+PAGE UP</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>CTRL+LEFT ARROW</td>
<td>Pan Left (moves image, if zoomed)</td>
</tr>
<tr>
<td>CTRL+RIGHT ARROW</td>
<td>Pan Right ARROW (moves image, if zoomed)</td>
</tr>
<tr>
<td>CTRL+UP ARROW</td>
<td>Pan Up (moves image, if zoomed)</td>
</tr>
<tr>
<td>CTRL+DOWN ARROW</td>
<td>Pan Down (moves image, if zoomed)</td>
</tr>
<tr>
<td>ESC</td>
<td>Clear current region (if main image has focus)</td>
</tr>
<tr>
<td>ESC</td>
<td>Clear selected pages (if thumbnails display has focus)</td>
</tr>
<tr>
<td>SHIFT+INSERT</td>
<td>Attach to Previous</td>
</tr>
<tr>
<td>SHIFT+BACKSPACE</td>
<td>Detach All</td>
</tr>
<tr>
<td>SHIFT+DELETE</td>
<td>Delete Pages</td>
</tr>
</tbody>
</table>

**Document list keys**

The focus must be on the document list to use these shortcuts.

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>LEFT</td>
<td>Previous page</td>
</tr>
<tr>
<td>RIGHT</td>
<td>Next page</td>
</tr>
<tr>
<td>UP</td>
<td>Previous document</td>
</tr>
<tr>
<td>DOWN</td>
<td>Next document</td>
</tr>
<tr>
<td>HOME</td>
<td>First page</td>
</tr>
</tbody>
</table>
### Contacting LexisNexis

LexisNexis® offers the broadest choice of discovery solutions, giving law firms, corporations and government agencies the efficiency, control, and confidence they need to litigate successfully in the face of overwhelming data volumes and rapidly changing technology.

#### Technical Support

Our number one priority is our clients. Our representatives pride themselves on resolving client issues quickly and effectively. To receive technical assistance, or to provide feedback or suggestions, please e-mail or call us. The Technical Support team is available from 9:00 A.M. to 8:00 P.M. Eastern Time, Monday - Friday.

- **E-mail:** lawsupport@lexisnexis.com
- **Phone:** 1 (800) 833-3346 (Option 5 for LAW PreDiscovery.)

#### Websites

**Litigation Solutions:**

http://www.lexisnexis.com/litigation

**LexisNexis® Early Data Analyzer:**
Our sales team is committed to helping you find the right products to suit your requirements. Contact us to learn more about the many flexible licensing options for LAW PreDiscovery®, and to see how our related software and service offerings for litigation support — such as Concordance®, CaseMap®, and IDEX Full-Service Expert Witness Search — can help to integrate and accelerate your efforts to arrive at winning solutions.

LAW PreDiscovery requires additional licensing to run. For more information on licensing, contact LexisNexis sales at LNGGlobalOpsLitigationsSalesTeam@ReedElsevier.com.

**Client Training Program**

To help you meet the increasing complexity of electronic discovery, our Client Training Program offers classroom experiences that focus on applying the powerful features of LAW PreDiscovery to solve real-world problems. To learn more about our training offerings, please e-mail or call us.

**E-mail:** litservtraining@lexisnexis.com
Index

- A -
activating
  software product keys  38
administrator  47

- C -
CaseLogistix
  Unicode export format  149
cases
  Unicode in case names  149
custom profiles  47

- D -
deactivating
  software product keys  38

- E -
Early Data Analyzer
  installing  15
  system requirements  10
EDrawings
  system requirements  10
EDRM XML
  Unicode export format  149
exporting  149
  delimited Unicode text  149
  Unicode  149

- F -
fields
  Unicode in field names  149

- G -
grids
  viewing Unicode  149
GUIDs  105

- H -
hotkeys
  listing of  150

- I -
importing
  Unicode  149
installation
  Early Data Analyzer  15
  LAW PreDiscovery  15
  Sentinel Server  15
  TIFF/PDF Printer Drivers  15

- K -
keyboard shortcuts  150

- L -
LAW PreDiscovery
  installing  15
  system requirements  10
LAW PreDiscovery overview  5
LAW Profile Manager
  administrative mode  47
LexisNexis contact information  153
License Manager  38
license server  47
licensing
  capabilities listed by UI element  142
  connecting to a license server  47
  LAW Profile Manager  47
  LexisNexis sales  153
  License Manager  38
  software key licensing  38
  temporary license in EDA  47
  temporary license in LAW  47
  LOCALHOST  47

- M -
metadata
  Unicode  149
OCR
  Unicode 149

password for Profile Manager 47
printing
  Unicode 149
Profile Manager
  administrative mode 47
  profiles 47

refreshing
  software product keys 38
release notes 8
resetting
  Profile Manager 47

Sentinel Protection Server
  installing 15
Sentinel RMS License Manager
  installing 15
shortcuts
  keyboard 150
software key licensing
  activating 38
  deactivating 38
  refreshing from the Internet 38
system requirements
  Early Data Analyzer 10
  LAW PreDiscovery 10

temporary license 47
TIFF/PDF Printer Drivers
  installing 15

Unicode
  language pack requirement 149
  summary of support 149

what's new 8
Word
  printing Unicode text 149

XML
  Unicode export format 149

Word
  printing Unicode text 149